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Building and Editing Structures with MedeA
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1 Structure Editing

1.1 Create New Structures

To build new and edit existing structures in simulation cells with periodic boundary conditions (crystal struc-
tures, slab surface models, etc.), use the Crystal Builder. The Crystal Builder is opened via File >>

New periodic structure . For more information, read the Section Building Crystal Structures.

To build and edit molecular structures, use the Molecular Builder. The Molecular Builder is available via
File >> New non periodic structure . The features of the Molecular Builder are described in the Molecular

Builder Section.

You can also build molecules via File >> New molecule from SMILES , using the Simplified molecular-
input line-entry system (SMILES) [1] notation as follows:

In the upper empty field, enter the molecule’s name to identify it within MedeA. In the lower empty field, enter
the SMILES text string. For instance, to create the caffeine molecule, enter the name Caffeine and specify the
SMILES text string CN1C=NC2=C1C(=O)N(C(=O)N2C)C. Confirm with OK to display the caffeine molecule
in the Molecular Builder.

[1] http://en.wikipedia.org/wiki/Simplified molecular-input line-entry system
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Within the Molecular Builder the molecule can be further modified (the features of the Molecular Builder are
described in the Section Molecular Builder ).

To build and edit mesoscale structures, use the Mesoscale Builder or the Mesoscale Converter. The
Mesoscale Builder is available via File >> New mesoscale molecule . The features of the Mesoscale
Builder are described in the Mesoscale Builder Section. Alternatively, you can convert an existing atomistic
structure to a mesoscale structure using the Mesoscale Converter. The Mesoscale Converter is available via
Builders >> Map atomistic/mesoscale systems and is described in the Mesoscale Converter Section.

1.2 Open Existing Structures

In addition to the native sci file format of MedeA, various other formats are supported for reading and import-
ing structure data. To open structure files from disk use File >> Open structure from disk . The supported

file formats are shown in the drop-down list below the selection bar Files of type.
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The supported structure file formats are

• MD Files (*.sci): the native format of MedeA

• Accelrys CAR Files (*.car): the legacy car format of the modeling software Materials Studio; reading
.car files requires that associated .mdf files are also present in the same directory

• CIF Files (*.cif): structure data stored in a crystallographic information file, a standard for crystallo-
graphic data interchange

• PDB Files (*.pdb): structure data stored in the format of the Protein Data Bank archive

• VASP Files (POSCAR, CONTCAR): structure data stored in the format the Vienna Ab-Initio Simulation
Package (VASP); requires that POTCAR files are also present in the same directory unless the files
contain elemental information

• XTL Files (*.xtl): legacy file format of Accelrys for crystal structures

• XMol Files (*.xyz, *.xmol): read files that contain a line with the number of atoms 𝑛, then by a title line,
followed by 𝑛 lines with four columns each with the element symbol, and the three spacial Cartesian
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coordinates; cell parameters are entirely omitted

• mmCIF Files (*.mmcif): A flexible and extensible tag-value format for representing macromolecular
structural data. For more information visit https://www.ebi.ac.uk/pdbe/docs/documentation/mmcif.html

• Mol2 Files (*.mol2): Tripos structure data that contain Cartesian coordinates and bond information; the
files can also contain cell parameters

• Gaussian LOG Files (*.log): read output files of the compute engine Gaussian

Select an appropriate file format/type, navigate with the file browser to a relevant directory, select the structure
file of interest, and confirm with Open .

Note: To learn more about a file format, you might want to write a structure to disk in the relevant file format
via File >> Export to file and examine the created file.

Structure data can also be loaded from previously performed MedeA jobs stored on an accessible Job-
Server. Select the relevant JobServer via Jobs >> Select Server >> . . . , followed by File >>

Open structure from job .

In the resulting dialogue, search for relevant sci files by expanding job records. You can also use the search

v. 3.9 Copyright © 2024 Materials Design, Inc., All rights reserved.
Materials Design® and MedeA® are registered trademarks of Materials Design, Inc.

12121 Scripps Summit Dr., Ste 160 San Diego, CA 92131

4 of 107

https://www.ebi.ac.uk/pdbe/docs/documentation/mmcif.html


D
O

C
U

M
E

N
TA

TI
O

N
MedeA Documentation

filters above the job records after clicking the on the icon . To close the search filters click on the icon

.

Job records can be filtered according to

• User : define the user who owns jobs on the selected JobServer (by default it is your username)

• Job Name : search for strings in the name of jobs or for the entire name

• Submitted : limit the records to the time when jobs have been submitted

• Started : limit the records to the time when jobs have been started

• Finished : limit the records to the time when jobs have been finished

• Status : limit the records to the status of jobs

• Job Numbers : search for structures of jobs with particular numbers

By default, the structure retrieval dialogue enables the option Hide intermediate files to reduce the number
of records. In particular, many intermediate files can be created by jobs that employ MedeA HT, MedeA
Phonon, and MedeA Transition State Search. However, in case you want to retrieve intermediate structures
disable (untick) the option Hide intermediate files and click on Refresh to show more structure records per
job entry. To see the actual sci file records expand relevant records in the list of jobs.

Reduce or increase the value for Number of jobs to display followed by a click on Refresh to show fewer
or more job records.

With MedeA module InfoMaticA you can also open crystal structures from the approx. 1.1 million records
in the MedeA structure databases. More information about MedeA InfoMaticA is provided in the Section
InfoMaticA.

1.3 Save Structures

Apart from using structures to submit MedeA jobs you can also save created structures either to the Materials
Design Database, to disk, or in structure lists.

To save structures to disk, click on File followed by Export to file . The supported file formats are visible in

the selection bar Files of type: .
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The supported structure file formats are

• SciCo Files (*.sci): the native format of MedeA

• XTL Files (*.xtl): legacy file format of Accelrys for crystal structures

• XMol Files (*.xyz, *.xmol): write files that contain a line with the number of atoms 𝑛, then by a title line,
followed by 𝑛 lines with four columns each with the element symbol, and the three spacial Cartesian
coordinates; cell parameters are entirely omitted

• Mol Files (*.mol): structure data stored in the mol format

• Mol2 Files (*.mol2): Tripos structure data that contain Cartesian coordinates and bond information; the
files can also contain cell parameters

• PDB Files (*.pdb): structure data stored in the format of the Protein Data Bank archive

• CIF Files (*.cif): structure data stored in a crystallographic information file, a standard for crystallo-
graphic data interchange

• Bitmap (*.bmp): pixel image in the Windows bitmap format

• PNG (*.png): pixel image in the portable network graphics format

• SVG (*.svg): scalable vector graphic image
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• TIFF (*.tiff): pixel graphic in the tagged image file format

Note: The quality and resolution of the image files (.bmp, .png, and .tiff depend on the display resolution.
The higher the display resolution, the finer is the created image.

To store a created periodic structure to the Materials Design Database invoke File >> Save to database .
In the appearing window enter the name that the structure should have in the Materials Design Database and
a remark about, e.g., how the structure was created. Confirm with OK

Only periodic structures can be saved to the Materials Design Database, i.e., structures in simulation cells
or crystal structures. Structures that were saved to the Materials Design Database can be retrieved with
InfoMaticA based on their formulas, names, and remarks. More information about InfoMaticA is provided in
the chapter InfoMaticA of the MedeA manual.

How to save structures in structure lists is described in chapter MedeA HT of the MedeA manual.

Hint: Every structure used to start a MedeA job is automatically stored on the JobServer and can be opened
via File >> Open structure from job .

1.4 Undo / Redo

MedeA has options to revert, i.e., undo an action (e.g., delete atoms, rotate structures) and to return to the
most current state that was achieved after the final action. The former option is called Undo and the latter
option Redo . Both options can be invoked in three different ways:

1. Via the Edit pull-down menu in the main menu bar
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2. With the key combinations Ctrl + z and Ctrl + y

3. With the icons and located on the left edge of the MedeA GUI (see next image).

2 Structure Positioning and Visualization

The MedeA GUI has a comprehensive set of options to position structures and to visualize atoms and bonds
in different ways. Key options are accessible via the icon bar directly underneath the main menu bar. Hovering
the pointer over each icon discloses a brief description in the yellow pop-up text.

2.1 Positioning Icons

The icons used to position atoms in the structure viewers are:

• : Pins or unpins the toolbar with the set of icons

• : the “settings” icon, shows 3D rendering options

• : Switches to the select mode to select one or more atoms. You can select atoms one-by-one by
simply clicking with the pointer on atoms. Dragging the pointer over a collection of atoms lets you select
several atoms.

• : Switches to the select molecule mode. If a group of atoms is connected with bonds (e.g., a
molecule or a fragment) then the entire group of atoms can be selected by clicking on one atom of this
group. To select several groups of connected atoms, drag the pointer over these groups of atoms.

• : Enables rotation mode. Within this mode, the entire structure can be rotated with the arrow keys
of the keyboard or by dragging the pointer.

• : Enables to rotate only selected atoms, fragments, or molecules. Within this mode only selected
atoms are rotated, and the positions of the non-selected atoms are maintained.

• : Enables translation mode. Within this mode, the entire structure can be translated with the arrow
keys of the keyboard or by dragging the pointer.

• : Enables to translate only selected atoms, fragments, or molecules. Within this mode only selected
atoms are translated, and the positions of the non-selected atoms are maintained.

• : Enables the zoom mode to decrease or increase the size of structures either with the arrow keys
of the keyboard or by dragging the pointer.

• : If enabled, previously displayed Miller planes can be translated with the arrow keys of the key-
board or the pointer.
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• : Start an 3D animation of the structure in the structure window; to stop the animation click on one
of the other icons

• : Re-center the active structure to fit into the structure window.

Hint: Miller planes can be only visualized in case of crystal structures, i.e. periodic structures. They are not
available for non-periodic structures, such as molecules and meso-molecular structures.

Table1: Summary of very useful key combinations to position and
select structures

Key combination Action
Crtl + z undo the last action
Crtl + y revert undo actions

Crtl + a select all atoms of the active structure
Esc clear the atom selection
Del delete selected atoms

z + , , or pointer move-
ment

increase or decrease the size of the entire structure in small steps

Shift + z + , , or pointer
movement

increase or decrease the size of the entire structure in large steps

t + , , , , or pointer
movement

translation of the entire structure by 0.1 Å along the vertical
and horizontal axes of the screen

Shift + t + , , , , or
pointer movement

translation of the entire structure by 1.0 Å along the vertical
and horizontal axes of the screen

s + t + , , , , or
pointer movement

translation of selected atoms by 0.1 Å along the vertical and
horizontal axes of the screen

Shift + s + t + , , ,
, or pointer movement

translation of selected atoms by 1.0 Å along the vertical and
horizontal axes of the screen

r + , , , , or pointer
movement

rotation of the entire structure by 1.0 degree around the verti-
cal and horizontal axes of the screen

Shift + r + , , , , or
pointer movement

rotation of the entire structure by 10.0 degrees around the ver-
tical and horizontal axes of the screen

Alt + r + , , , , or
pointer movement

rotation of the entire structure by 1.0 degree around the axes
perpendicular to the screen

Alt + Shift + r + , , ,

, or pointer movement

rotation of the entire structure by 10.0 degrees around the axis
perpendicular to the screen

s + r + , , , , or
pointer movement

rotation of selected atoms by 1.0 degree around the vertical
and horizontal axes of the screen

Shift + s + r + , , ,
, or pointer movement

rotation of selected atoms by 10.0 degrees around the vertical
and horizontal axes of the screen
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2.2 3D Settings Dialogue

Click on the icon to set 3D rendering options. With this icon you open a settings dialogue box with the
following tabs:

• General

• Atoms

• Bonds

• Cell

• Labels

General Tab

This tab, with the following sections, controls the general settings for viewing the structure.

• Section Defaults

– Set : Set your custom default parameters with the selected choices.

– Use : Apply your custom default parameters

– Reset : Reset your custom default parameters from the default settings of MedeA
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• Section System display

– Quality: Sets the drawing quality of the atoms and bonds. Higher values imply higher qualities.

– Background: Sets the drawing area background color. Clicking on the color box next to the option
name opens a new dialogue for setting the background color

– Depth cueing: Applies depth cueing or fog effect

– Projection: Sets the viewing type: Ortho or Perspective; for the latter feature the perspective
factor is adjustable via the spin box on the right

• Section Lights: Defines how structures are illuminated

– Number: the number of lights sources

– Style: the style of the light sources

• Section Axes: Sets whether to plot the axes icon, and if yes, where to place the icon and the size of
the icons.

– Show labels: removing the mark from the check box erases the labels X, Y, and Z of the axes.
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Atoms Tab

Analogous to the icons below the main menu bar of the MedeA GUI, the Display Style: Section allows

you to switch between the supported display styles such as CPK (Spheres) , Ball & Stick , Point Atoms ,

Hide Atoms , Cylinders , and Lines . Confirm each change with Apply .

In Section Colors and Sizes you can

• Change element radii. . . (for more information, see Section Define Element Radii)

• Change element colors. . . (for more information, see Section Define Element Colors)

• Change subset color. . . (for more information, see Section Define Subset Color )

• Set Atom scale factor

Define Element Radii

With the option Change element radii. . . in the Atoms tab of the 3D Settings Dialogue determines the size

of the spheres in the ball & stick visualization style. A click on the option Change element radii. . . results in
the appearance of a window containing the periodic table. Click on one of the elements in the periodic table
for which you want to change the radius, e.g., B (boron). In the next window that appears change the radius
and confirm with OK . Also click OK in the window with the periodic table. To finalize the change on the
radius, click on Apply in the in the Atoms tab of the 3D Settings Dialogue.
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Define Element Colors

The option Change element colors. . . determines the color of the elements in all visualization styles. Click

on the option Change element colors. . . to open a window that contains the periodic table of the elements.

MedeA provides four element color schemes. Each color scheme is stored in files with the extension mdm-
dacs that are located in the folder data folder of the MedeA installation directory. The color scheme can be
loaded via Read scheme . Click on this button to browse to and select the mdmdacs file of the preferred
color scheme:

• MedeA colors (MD default.mdacs)

• Jmol colors (jmol elementcolors.mdacs)
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• Rasmol colors (rasmol elementcolors.mdacs)

• Vesta colors (vesta elementcolors.mdacs)
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You can also create your own color scheme and store that in a mdmdacs file to disk. Click on one of
the elements in the periodic table for which you want to change the color, e.g., Mn (manganese). In the
next window that appears, change the color and confirm with OK . To write the modifications to disk use
Write scheme . Click on MedeA default set the color scheme back to the MedeA standard color scheme.

Click OK in the window with the periodic table to return to the 3D Settings Dialogue. To finally change the
color click on Apply in the in the Atoms tab of the 3D Settings Dialogue.

Define Subset Color

With the option Change subset colors. . . change the colors of atoms of subsets that exist in the active

structure. Click on the option Select color. . . to open a window that summarizes the color settings for each
existing subset.

Hint: In case a structure does not have any subset then this window is empty. Read the Section Create
Subsets of Atoms to learn how to create subsets.

Click on the Select color. . . button to bring up a color editor.
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In the color editor set and create a color and confirm with OK . Also click OK in the window with the color
settings summary for existing subsets. To finally change the color click on Apply in the in the Atoms tab of
the 3D Settings Dialogue.

Atoms scale factor

A spin box that increases or decreases the atom sizes for all atoms in the CPK visualization style and the
mixed model. By default, the value is 1.0, i.e., the radii of the spheres in the CPK visualization style are
identical to the van der Waals radii of the elements.

Bonds Tab

In the Bonds tab you can modify how bonds (cylinders) are displayed in the visualization styles ball & stick
and cylinders and in the mixed model. Confirm any modification with Apply .
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With the option Clip you can define whether bonds (connections) between atoms should be visualized

between atoms and the cell edges ( at view boundary ), terminate at atom boundaries ( at atoms ), or hidden

if they cross cell edges ( as stubs ).

Define the thickness of bonds with the option Radius: spin box. The default is 0.1. Increase the radius to
0.2 to double the bond thickness.

In the Section Coloring define whether bonds should have the same color as the atoms ( by element ) or

should be drawn in another color ( specified ). For the latter case, click on Choose color and set the color

in the color editor dialogue. To modify, close the color editor with OK and confirm with Apply in the in the

Atoms tab of the 3D Settings Dialogue.

Cell Tab

• – : reduces the min. and max. view limits simultaneously by 0.5 units of the cell

• - : reduces the min. and max. view limits simultaneously by 0.05 units of the cell

• >< : resets all min. view limits to 0.0 and max. view limits to 1.0 units of the cell (displays content of
the entire cell)

• + : extends the min. and max. view limits simultaneously by 0.05 units of the cell

• ++ : extends the min. and max. view limits simultaneously by 0.5 units of the cell

• Min and Max viewing limits for x: , y: , and z: : define which part of a structure should be displayed.
Set whether the entire structure should be visualized, only a fraction, or also, atoms that go beyond the
cell boundaries.
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• Include atoms on the maximum border : visualize also atoms that are directly located on the view limits

Labels Tab

You can tag each atom of a structure with the following labels:

• Atomic number : The location of the element in the periodic table; is identical to the charge of the
nucleus of an element.

• Atomic symbol : Chemical symbol of the elements

• Calculated charge : Charge that is calculated with one of the MedeA compute engines

• Fractional coordinates : The triplet of spatial coordinates in units of the lattice parameters. Only visible
for periodic structures.

• Index : Index of the atom

• Name : Flag to identify particular atoms, beads, particles, etc.

• Number of bonds : Number of connections to other atoms, independent on the bond order

• Point : Numbering of atoms that can be created from asymmetry-inequivalent atom by point-group
operations such as rotation, mirroring, etc.

• Site (only visible for periodic structures): Crystallographic site number, e.g. 1 for a, 2 for b, 3 for c, etc.

• Spin : Magnetic moment, assigned or calculated (in units of 𝜇𝐵

• Symmetry parent : symmetry parent of the atom

• Wyckoff position (only visible for periodic structures): Point belonging to a set of points for which site
symmetry groups are conjugate subgroups of the space group (see more at Wikipedia [2]

• Bead : Assigned mesoscale forcefield type

• Bead mass :Mesoscale forcefield mass

[2] https://en.wikipedia.org/wiki/Wyckoff positions
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If desired, select another font and color for the labels.

Confirm modifications with Apply .

2.3 Visualization Icons

The MedeA GUI has a comprehensive set of visualize the atoms of structures in different ways. Key options
are accessible via the icon bar directly underneath the main menu bar. Hovering the pointer over each icon
discloses a brief description in the yellow pop-up text.

The icons to specify how atoms, bonds, etc., should be visualized are:

• : Draw atoms as large spheres, without bonds - set sphere sizes with the Atoms scale factor spin

box of the Atoms tab from the 3D rendering options (the “gear ” icon: )

• : Draw atoms as small spheres, with bonds as cylinders - set sphere sizes and the thickness of
the cylinders via Change element radii. . . in the Atoms tab from the 3D rendering options (the “gear

” icon: )

• : Draw atoms as small spheres, without bonds - set sphere sizes via the gear icon

• : Draw bonds as cylinders and isolated atoms as tiny spheres - set the thickness of cylinders in the

Bonds tab of the 3D rendering options (the “gear ” icon: )
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• : Draw bonds as lines and isolated atoms as crosses

• : Draw structures in mixed mode - requires selected atoms; more instructions are provided in the
Section Mixed Structure Visualization

• : Hide all atoms

• : Show/hide detected hydrogen bonds as cylinders - hydrogen bonds are detected based on defi-
nitions in the Miscellaneous tab of MedeA Preferences ( File >> Preferences )

– Maximum distance (Ang): - determines the distance between the donor and acceptor that have
a hydrogen atom in-between

– Minimum angle (deg): - determines the angle donor-H atom-acceptor, whereby the H atom is the
apex

With the reasonable default values of 3.0 Å and 160.0 degrees, all meaningful H bonds are captured.
For instance, if the value of the Minimum angle (deg) is too close to 180 degrees then no H bond
might be detected.

You can modify the list of elements for donors and acceptors. Simply click on the icon to open
a window with the periodic system of the elements (periodic table). In the periodic table select the
elements that should act as donors and acceptors, respectively, and confirm with OK . The newly
selected elements should appear in the list of Donor ligand(s) and Acceptors .

By default, the color of the dashed lines and cylinders is green. This color can be changed with a click
on Change , which opens a color editor to define another color.

• : Show/hide detected hydrogen bonds as lines
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• : Show/hide the cell (this icon is only visible for periodic structures)

2.4 Viewing Large Structures

To view larger structures, you can use the draw bonds on lines visualization . However, you will need to
change the background color to something other than white to see selected atoms, as these are shown in

white. You can change the background color via the icon .

Furthermore, the style and quality of view can be set based on the number of atoms in the system in the

System Quality tab of the settings dialogue box .

2.5 Render Structure Views with POV-Ray

MedeA has the feature to create from structure views images and pictures that are rendered with the program
POV- (Persistence of Vision) which you can obtain from the official POV- Download Page [3]. Once you have
installed the POV- executable you should define in the Programs tab of the MedeA preferences ( File >>

Preferences. . . ) where the POV- executable is located.

To render a view of an active structure open the POV- dialogue with File >> Export to POV- ).

In the General tab define the

• name and location of the output file

• graphic format

• the size (width, height, and unit)

• the resolution

of the final image.

[3] http://povray.org/download
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To change the location and name of the POV- input files and the created image file either use the browse
button ( . . . ) or directly change the string in the text field. For the graphic format chose between one of the
supported options. The default size of the image is defined according to the size of the view on your screen.
However, you can let make POV- create a smaller or larger image depending on the values that you define
for Width: and Height: . Note that the MedeA maintains the ratio of width and height to avoid any distorted

structure images. While you change the unit for the dimensions between pixels , inches , and cm also the

values for Width: and Height: are adapted.

In case the unit is either set to inches or cm then also the value for Resolution: change the dimensions.
An increase of the default resolution of 72 implies a reduction of the dimensions whereas a reduction of the
resolution lets the dimension of the image increase.

In the Details tab define whether and how to depict the simulation/crystallographic cell and set the back-
ground color of the final image.
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By default, the cell is included in the rendered image. To exclude the cell, remove the tick-mark from he
Show cell option. In case you want to change the thickness of the lines of the image to display the cell,

modify the value of the option Cell radius: .

The color of the lines that depict the cell in the image and the color of the background in the image can be
modified with a click on the browse button . . . of the options Cell color: and Background color: . A click
on the button . . . brings up a window to edit the color.

To start the rendering of the structure view and creation of the image click on Apply .

Hint: The directory that contains the image - as defined in the Section Output file - also contains the POV-
input files. Feel free to modify and customize the POV- input files according to your needs with the assistance
of the POV- documentation [4] and other information available at the POV- site [5].

3 Subset Manager: Create Subsets of Atoms

Within MedeA, subsets are sets of atoms that belong to particular molecules and fragments, are of the same
element, have the same forcefield atom type, are selected, etc. Subsets are very useful and can even
be required to, for example, graphically distinguish groups of atoms with different properties using different
visualization styles, to analyze results, or to post-process data from calculations.

You have three possibilities to create subsets of atoms in periodic structures and molecular structures via
the Subsets item of the Context Menu in the Periodic Structure Viewer , the Context Menu in the Molecular
Builder and the Context Menu in the Mesoscale Builder .

• Create. . . : Define a subset based on a set of atomic criteria (properties)

[4] http://povray.org/documentation/
[5] http://povray.org
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• Create subset from selection. . . : A subset is defined based on a previously selected atoms

• Create subset from a connected pattern : Define a subset based on a pattern that is formed by atoms
that are connected, e.g., a molecule, a fragment

3.1 Create a Subset Based on Atomic Criteria

The following three dialogues can be displayed upon right-click in a structure window >> Subsets : >>

Create. . . , depending on the length of the subset and other options that are enabled or disabled:

• Define a subset of Length: 1

• Define a subset of Length: 2
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• Define a subset of Length: 3
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Note: Any modification in the Create Subset tab of the subset manager must be confirmed with a click on
Apply .

Hint: Click on the Help button to open a comprehensive overview and explanation of the purpose of
subsets and the required parameters to create subsets.

Within the Create Subset tab you can define a subset with the following options:

• Subset name: - is required to identify the subset within MedeA; subsets without a name are not per-
mitted

• Length: - Define the length of the subset

– 1 - is for an atom or a group of atoms

– 2 - is used to create a subset that consists of an atom pair that may be used to define vectors,
directions, etc.

– 3 - is used to create a subset that consists of three atoms that may be used to define angles,
etc.

• Subset color: - Click on Change to re-define the color of the atoms upon selection of the subset

• Select and highlight subset - tick/enable this option if the atoms of the subset should be selected and
highlighted in the defined color immediately after the subset is created

• Random type - tick/enable this option if the created subset should encompass only a randomly se-
lected sub-amount of all the atoms that meet the criteria for this subset. To define how many atoms
should be randomly selected of the total amount of possible atoms toggle between
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– percent

– atoms

With the former argument define a percentage of atoms whereas with the latter argument you can
define a total sub-amount of atoms.

Hint: A sub-amount of 0% and 100% selects none or all possible atoms, respectively.

• Define a region: - tick/enable this option if the created subset should encompass atoms that are lo-
cated in a particular region of the active structure.

– Mark one of two options to define the region either Through (x y z) range: or Through a sphere:

– In general the regions are defined by coordinates, either as Cartesians , i.e., in units of Å or
Fractionals

– Define region Through (x y z) range:

* Set the values for the three spacial coordinates x , y , or z as ranges, such that they are
either

· is between two values

· is greater than , i.e., larger than a value

· is greater than or equal to , i.e., larger than or identical to a value

· is less than , i.e., smaller than a value

· is less than or equal to , i.e., smaller than or identical to a value

Next to the selection bars enter the values in the field(s) in units of Å (Cartesian coordinates)
or fractions of the lattice parameters (Fractionals) of the active structure

– Define region Through a sphere:

* Specify the center of the sphere either with

· spacial (x, y, z) coordinates or

· selected atoms - option is visible only if atoms are selected in the active structure

and with a Radius: in units of Å

* In case you want to specify the center with coordinates, set the values for the three spatial
coordinates x , y , or z in the three fields, either in units of Å (Cartesian coordinates) or
fractions of the lattice parameters (Fractionals).

* In case you want to specify the center with selected atoms: and also mark the option
Define one sphere for entire selection , then set the center definition either as

· Geometrical center (of the selected atoms),

· Center of mass (of the selected atoms), or

· Bounding box center (it is the center of an orthorhombic cell that encloses all selected
atoms)

* In case you want to specify the center with selected atoms: and also mark the option
Define one sphere per atom of the selection then no other parameters need to be specified

except the Radius: of the sphere.

Use the following criteria (atomic properties) to select atoms that should constitute subsets:
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• Atomic number : number of the element in the periodic system (e.g. C has the atomic number 6) of
molecules have this flag, if the chains were created with the Polymer Builder )

• Atomic symbol : symbol as defined in the periodic system of the elements

• Name : name of atoms as defined in, .e.g the Atoms Spreadsheet

• Number of bonds : amount of bonds/connections to nearest neighboring atoms and next-neighboring
atoms

• Spin : magnetic moments of atoms, either initialized via the Magnetic Moments Tab of the Crystal
Builder or calculated with VASP; enter values in unit of 𝜇𝐵

• Frozen : atoms with partially or entirely fixed coordinates

• Forcefield atom type : assigned atom type of the active forcefield (FF) selected via Forcefields >>

Choose

• Forcefield atom charge : assigned charge based on the assigned FF atom type

Note: Each added criterion can be removed with the X button. Press the button to update the list of
available criteria.

For criteria that imply to enter text (single letters or strings), the available matching attributes are:

• is : is true if the criterion is equal to the defined value

• is not : is true if the criterion is not equal to the defined value

• is like : is true if the criterion partially matches the defined value

• is not like : is true if the criterion partially does not match the defined value

• contains : is true if the criterion contains the defined value (the value must be enclosed with “*”)

For criteria that imply to enter numbers, the available matching attributes are:

• is between value 1 and value 2: is true if the criterion is between the two numbers value 1 and
value 2

• is within value 1 of value 2: is true if the criterion is within the number value 1 of number value
2

• is equal to value: is true if the criterion is equal the number of value

• is less than value: is true if the criterion is less than the number of value

• is greater than value: is true if the criterion is greater than the number of value

• is not equal to value: is true if the criterion is not equal the number of value

• is less than or equal to ‘‘value‘ : is true if the criterion is less than or equal to the number of value

• is greater than or equal to ‘‘value‘ : is true if the criterion is greater than or equal to the number of value

For the criterion Frozen the available matching attributes are the spatial coordinates

• x

• y

• z

• all - selects all three former attributes at once
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In case the Length of the subset is either 2 or 3 , then you may also define at the very bottom of the
dialogue how pairs or triplets of atoms, respectively, should be created. If Length is set to 2 then the
process effectively generates two separate lists of atoms and MedeA must be informed how to combine
members of these two lists to create the final list of atom pairs. The available options are as follows:

• i=j : In this case, each member of the list referring to atom 1 is paired with the corresponding member
of the atom 2 list. This implies that the two atom lists generated by the definition criteria must contain
equal numbers of atoms.

• i<j : Here, the pair subset will contain the first member of the atom 1 list paired with the second,
third and higher members of the atom 2 list. To this are added additional pairs containing the second
member of the atom 1 list together with the third and higher members of the atom 2 list, and so on.

• i>j : This option is essentially the reverse of the case i<j

3.2 Create a Subset Based on Selected Atoms

An alternative straightforward procedure to define static subsets is based on selecting atoms. Simply click on

the icon to switch to the select mode and select one or more atoms. Once atoms are selected invoke
Subsets >> Create subset from selection. . . of the Context Menu in the Periodic Structure Viewer or the

Context Menu in the Molecular Builder .
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The key required step is to define a Subset name: to identify the subset within MedeA (subsets without a
name are not permitted). Finally, confirm with Apply .

Prior to defining a subset based on the selected atoms you can also give the subset a particular color:

• Subset color: - Click on Change to re-define the color of the atoms upon selection of the subset

• Select and highlight subset - tick/enable this option if the atoms of the subset should be selected and
highlighted in the defined color immediately after the subset is created

With marking the option Extend selection: you can create a subset that contains more atoms than the
atoms that are selected in the active structure. Use the following options to define how the selection should
be extended:

• Define one sphere for entire selection : The selection is extended based on a sphere that is centered

at the point in space which is defined by the option Define the center: which can have the values

– Geometrical center (of the selected atoms)

– Center of mass (of the selected atoms), or

– Bounding box center (it is the center of an orthorhombic cell that encloses all selected atoms)

• Define one sphere per atom of the selection : The selection is extended based on one or several
spheres that are each defined by the selected atoms. If only one atom is selected then the selec-
tion is extended by one sphere that is centered around the selected atom. In case several atoms are
selected then around each atom a sphere is created, centered at the position of the associated atom.
The selection of atoms is extended by all atoms that are located in the volume that is formed by all
spheres.

• Select complete molecules : If atoms of the extended selection are connected (bonded) to other atoms
that belong to molecules then the also all atoms of the molecules are considered for the subset that
you want to create.

• intra-molecular extension : If atoms of the extended selection are part of a molecule the also all atoms
of this one molecule are considered for the subset that you want to create. However, none atom of
other molecules are included in the subset.

• Radius : Define the radius of every sphere that is used to extend the extension, in units of Å

3.3 Create Subset from a Connected Pattern

Within MedeA you can create subsets of atoms in an active structure that are arranged and connected such
as atoms of a provided pattern. The latter can be a cluster of atoms, molecule, or fragment which are formed
by two or more atoms that are connected with bonds of the same order or different orders.

The following four dialogues can be displayed upon right-click in a structure window >> Subsets : >>

Create Subset from a Connected Pattern , depending on which options are selected:
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The functions of each option in the dialogue are as follows:

• Subset name: - is required to identify the subset within MedeA; subsets without a name are not per-
mitted

• Subset color: - Click on Change to re-define the color of the atoms upon selection of the subset

• Select and highlight subset - tick/enable this option if the atoms of the subset should be selected and
highlighted in the defined color immediately after the subset is created

• Ignore bond order - add mark in check box if the selected pattern should be used without paying
attention whether atoms are connected with single bonds, double bonds, partial/aromatic bonds, or
triple bonds

• Allow overlapping - add mark to check box if patterns that are detected in the active structure can also
overlap, i.e., are not separated by one or several atoms

• Search within selection - consider only selected atoms of the active structure to search for the relevant
pattern

• From selection - search for patterns in the active structure that are identical to the pattern which is
formed by the atoms of the active structure that are selected

• From MedeA - use a structure as pattern that is visualized in the MedeA GUI

• From file - load a pattern from a structure file

• From fragment - load a pattern from the fragment library of MedeA
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3.4 Freeze atoms of Subsets

In the Modify Subset tab of the subset manager coordinates of atoms of particular subsets can be frozen or
released:

• + : add another subset to the list of subsets that should have atoms with with frozen coordinates

• - : Remove a subset from the list of subsets that should have atoms with with frozen coordinates

• Define the names of the subsets with atoms that have frozen coordinates (e.g. subset2 )

• Add a mark to the relevant radio button to either Freeze or Unfreeze all components of atoms

• In the Axis selection add mark to the check box of the coordinates that should be frozen of released
(unfrozen). With the option all add marks to the three check box of

• x , y , and z at once.

Confirm any modification with Apply .

3.5 Split-up Structure-Wide Subsets

With this option you can split-up structure-wide subsets into subsets per molecule/atom.

• + : add another subset to the list of subsets that should be separated.

• - : Remove a subset from the list of subsets that should be separated.

• Define the names of the subsets with atoms that should be separated (e.g. subset1 .
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Confirm any modification with Apply .

3.6 Rename Subsets

In the Modify Subsets tab of the subset manager subsets can be renamed:

• Select the subset to rename: : Define which subset should get a new name

• Choose a new name: : Enter a new name for the defined subset, e.g. subset5

Confirm any modification with Apply .

3.7 Create Random Sub-Devisions of a Subset

With the Random sub-division option you can create a new subset that consists of a particular amount of
randomly selected atoms of an existing subset. Also you can keep a particular number of randomly selected
atoms of an existing subset and exclude the other atoms from a subset.

• Select a subset: Define the subset that should be modified

• Define how many atoms should be randomly selected atoms should be kept in in a subset of should be
used to create a new subset:

– percent
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– atoms

With the former argument define a percentage of atoms whereas with the latter argument you can define a
total sub-amount of atoms.

Toggle whether the defined subset should be updated or a new subset should be created with the randomly
selected atoms.

Confirm any modification with Apply .

3.8 Merge Subsets

With the Merge subsets option in the Modify Subsets tab you can unite two or more subsets into an existing
subset or a newly created subset.

• + : add another subset to the list of subsets that should be combined

• - : remove a subset from the list of subsets that should be combined

• Toggle between the option to combine all subsets into the first subset of the list or define the name of a
newly created subset

• Mark the check box of the option Remove initial subsets after combination if all of the combined sub-
sets should be erased, except the subset that accommodates all combined subsets.

Confirm any modification with Apply .

3.9 Attach Fragments to Atoms of Subsets

With the Attach Fragments option in the Modify Subsets tab you can bound selected fragments and atoms
to the atoms of the selected fragment.
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• Toggle whether something should be attached to atoms from a subset or from a selection

• All other options of the Attach fragment feature are described in the Section Attach Fragments

Confirm any modification with Apply .

3.10 Convert Subset

With the Convert Subset option in the Modify Subsets tab you can convert a subset with the length 2 in a
subset with the length 1.
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• Select a subset to convert: : Define the subset that should be modified

Toggle whether the defined subset should be updated or a new subset should be created.

Confirm any modification with Apply .

3.11 Subset Overview

The table in the Subsets tab of the subset manager is a summary of all subsets that are defined in the active
structure.

The table records provide information of how many atoms a subset encompasses, whether coordinates of
atoms are frozen, and in which color the atoms are depicted if a subset is selected. A right-click on a selected
recorded opens a context menu with basic table operations

• sort the order of the table rows

• format the content of the table cells

• copy the content of a column
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• move row up and down

and with items to modify the subsets, such as

• rename a subset

• split subsets

• delete a subset

• merge subsets

• randomly sub-divide subsets

• freeze coordinates of atoms of a subset

• attach fragments to atoms of subsets

• change color of subsets

If more than one row is selected the chosen action is applied with all the selected subsets. You can select
two or more subsets by clicking on table rows while pressing the CTRL key of the keyboard.

4 Mixed Structure Visualization

In the mixed visualization mode, you can visualize different parts of structures with the styles

• spheres (CPK)

• ball and stick

• cylinders

• lines

MedeA can also hide particular atoms to omit atoms in the visualization without deleting atoms from struc-
tures.

A few examples are:

Two steps are required to display structures in the mixed visualization mode:

1. Click on the icon in visualization icon bar
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2. Select atoms either by switching to the Select mode

• right-click >> Mode >> Select or click on the icon )

or select previously defined subsets via

• right-click >> Subsets >> Select atoms in subset

Once atoms are selected the following items are accessible via the Selection item of the Context Menu in
the Periodic Structure Viewer or the Context Menu in the Molecular Builder :

• Display as CPK : visualize selected atoms as spheres

• Display as Ball & Sticks : visualize selected atoms as balls connected with sticks

• Display as Sticks : visualize selected atoms as sticks only

• Display as Lines : visualize selected atoms as lines

• Hide : do not show selected atoms

Hint: To visualize large parts of structures as cylinders, lines, or even hide many atoms it is recommended
to first select the smaller part of the structure that should not be highlighted, then invert the selection via
right-click >> Selection >> Invert , and finally use right-click >> Selection >> Display as . . . .

5 Building Crystal Structures

In MedeA, you can either build structures from scratch or you can use experimental structures as templates
or building blocks.

5.1 Starting from Bulk Structures in InfoMaticA

Most likely, you will find your system of interest or a closely related structure in one of the MedeA structure
databases which can be retrieved with InfoMaticA. From a computational point of view, a crystal structure
under ambient pressure and room temperature is close to the low temperature structure determined by a
DFT calculation. Starting computations that employ, e.g. DFT methods or interatomic potentials (forcefields)
from experimental structure data usually is a very good option. If the system you have in mind is not available
in InfoMaticA, try finding a closely related system and modify it by editing and moving atoms and changing
lattice parameters.

5.2 Starting with an Empty Cell

To build a crystal structure manually from scratch you need to know its crystal symmetry, lattice parameters,
and atomic positions. If you know the space group symmetry of the system, MedeA will help you in setting
up the remaining parameters using symmetry.

To build a crystal structure from scratch, select New periodic structure from the File menu in MedeA’s main

window or press the key combination Ctrl + N on your keyboard to bring up the builder window.
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You could start adding atoms right now, but it is more efficient to choose the desired symmetry before adding
atoms. This way, symmetrically equivalent atoms will be recognized as such and positioned at proper lattice
sites.

Right-click into the structure window and select Edit Symmetry. . . from the context menu.

Select the desired space group in the Symmetry menu and click Apply . For example, to build a structure,

select for Centering: Body centered , afterward in the other selector the space-group Immm , and confirm
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with Apply .

Hint: All further operations like modifying lattice parameters in the Cell tab and modifying atomic properties
in the tabs Add atom , Move atom , consider the newly defined symmetry, unless you explicitly lower the
symmetry back to P1, as described below.

The Cell tab shows only those lattice parameters that can be modified within the symmetry restrictions. In
our example, the Cell tab shows only the cell lengths A:, B:, and C:. This is consistent with body-centered
tetragonal crystal structures which always have cells with angles of 90 degrees.

6 Editing Crystal Structures

The Crystal Builder lets you change a structure’s symmetry, cell parameters, atomic positions, atomic de-
grees of freedom, atomic masses, add or replace atoms, and create a magnetic structure by setting initial
magnetic moments (spins) for specific atoms.

To start the Crystal Builder, right-click into the structure window and select Edit Cell from the context menu
or select Edit >> Edit Structure. . . in MedeA’s main menu.
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6.1 Cell Tab

The Cell tab lets you change the cell parameters of the currently active structure while considering the cur-
rent symmetry (space-group). Lower the symmetry to P1 (see below) before trying to change cell parameters
in such a way that breaks the current symmetry.

Check the Don’t move atoms box to change the lattice parameters without moving atoms. This can be
useful for creating gaps or slab structures or for manipulating cells that contain molecules.

6.2 Symmetry Tab

This tab shows the symmetry of the currently active structure window. It allows you to lower or raise the
symmetry if MedeA finds a higher space group. Also, if a primitive cell exists for the crystal system, the
dialogue shows the two options

• Change to primitive cell in P1, preserve orientation .

• Change to primitive cell in P1, rotate to standard orientation

Enable/tick the option create new system to create a new structure window when applying any of the sym-
metry actions.

Set a Tolerance value to change the precision parameter that MedeA uses in the symmetry finder (MedeA
uses a relative tolerance to check for lattice site symmetry. Increase the tolerance to e.g. 0.1 to find more
identical positions, i.e. higher symmetry. Click Apply to use modified tolerance settings.

6.3 Add Atom Tab

To add atoms to the structure, do the following:
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1. Type the chemical symbol to add an atom or select an element from the periodic table (icon )

2. Select atomic symmetry positions from the Position selection bar (left-hand side)

3. Use sliders to define position or type in atom coordinates directly: all coordinates are in relative unit
cell coordinates (Fractionals).

As with all other operations affecting symmetry, the features in the Add Atom tab consider the symmetry of
the current system; so multiple atoms will be added automatically due to symmetry.

Note: To ignore symmetry constraints, first lower the symmetry of the system to P1.

To add atoms click on Add .
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6.4 Edit Atom Tab

The Edit Atom tab allows you to:

• Select an atom from the Atom list and replace it with a different element. Note, that atoms on symme-
try equivalent positions are replaced as well. Selected atom types are highlighted in pink in the MedeA
structure window.

To select an atom type to replace the present atom, you can either type in the chemical symbol or click

on the periodic-table icon to open a small periodic table and select an element from the table.

Confirm every change with a click on the icon . Close the Edit Atom tab and discard modifications

with a click on the icon .

Note: You can also use the Atoms Spreadsheet to exchange elements.

• Translate atoms. Make your changes and then click on the to confirm the changes or click to
discard changes. If you would like to make changes that break the current symmetry do the following:

1. Lower symmetry to P1 in the Symmetry tab

2. Switch to the Move Atom tab and make changes (all degrees of freedom will be available)

3. Click on Symmetry to find the new symmetry

4. If a new symmetry was found, you may raise the symmetry by clicking Raise symmetry to. . .

Note: Positions for each atom are given in relative cell coordinates (left) and in Wyckoff symmetry
notation (right).

• Freeze Atoms.

MedeA modules such as VASP, Phonon, Transition State Search, MT, LAMMPS, etc., change their
behavior with frozen atomic positions, i.e., if coordinates are not permitted to change in calculations. In
structure relaxations and molecular dynamics simulations with VASP, frozen atoms remain at their initial
positions. In Phonon calculations the contribution of “frozen atoms” to the lattice vibrational spectrum
(i.e., their force constants) will not be calculated. This is useful if, for example, just the frequency of
a bond stretch of a molecule bound to a surface is required, but not the full phonon dispersion or
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vibrational spectrum of the molecule-surface system. Most of the MedeA modules issue a warning
message if frozen atoms are present in structures.

The steps to freeze atomic positions:

1. Select an atom from the list of atoms

2. Click the x , y , and/or z depending on which directions of atomic motion you want to prevent;

click on Freeze all to freeze all spatial coordinates of a selected atom

3. Confirm with a click on the icon after each change, especially before selecting another atom

Note: Within MedeA you can freeze atoms in various ways:

– Use the Freeze Atom tab of the Crystal Builder

– In a structure window, right-click on an atom >> Atom >> Freeze. . .

– In a structure window select an atom, a group of atoms, or a molecule, right-click somewhere in
the structure window >> Selection >> Freeze selected atoms. . .

– Open the Atoms Spreadsheet and select in the Freeze column which coordinates to freeze (for
information read the Section about the Atoms Spreadsheet)

• Magnetic Moment

Modify initial spin configurations of specific atoms. MedeA considers initial magnetic moments set by
the user when running VASP calculations. This action imposes only an initial magnetic structure; the
actual value of the magnetic moment is calculated self consistently by VASP.

Select an atom from the list and set the magnetic moment (units are 𝜇B). Confirm with a click on the

icon after each modification.

Note: Within MedeA you can define initial magnetic moments of atoms in two ways:

• Use the Edit Atom tab of the Crystal Builder

• Open the Atoms Spreadsheet and set a value in the Spin column (for information read the Section
about the Atoms Spreadsheet)

To break the initial symmetry by imposing atomic magnetic moments, you need to lower the symmetry first to
P1 ( Symmetry tab), then set magnetic moments, and raise the symmetry again.

Note: The magnetic symmetry is taken into account in the Symmetry tab!

• Mass

Mass of each atom can be modified (e.g. for studying isotope effects in dynamics or vibrational analy-
sis).

Note: Within MedeA you can define atom masses in two ways:

• Use the Edit Atom tab of the Crystal Builder

• Open the Atoms Spreadsheet , right-click in one of the header cells >> New >> Mass , scroll to
the rightmost column, and define the mass in the relevant cells.
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6.5 Atoms Spreadsheet

Using the Atoms Spreadsheet you can also visualize and change several atomic properties. Use the Atoms
Spreadsheet to

• visualize atomic properties in complex structures

• change the following atomic properties:

– Names

– Elements / Atomic numbers

– Fractional x, y, z coordinates

– Occupancies of positions and sites

– Spins (magnetic moment)

– Freeze states (degrees of freedom)

– Forcefield (FF) Atom Types

– FF Charges

– Atomic masses

To toggle the spreadsheet view on/off, click on the select side panel icon to choose which type of side
panel to show. Choose the Atoms spreadsheet.

Then click Show side panel icon to activate the atoms spreadsheet:

The currently active structure window splits into two panels, with the structure on the left and the spreadsheet
on the right.

The usual table operations such as sorting and filtering also work in the Atoms Spreadsheet.

v. 3.9 Copyright © 2024 Materials Design, Inc., All rights reserved.
Materials Design® and MedeA® are registered trademarks of Materials Design, Inc.

12121 Scripps Summit Dr., Ste 160 San Diego, CA 92131

45 of 107



D
O

C
U

M
E

N
TA

TI
O

N
MedeA Documentation

To select an atom, in the structure window, change to selection mode (press the s -key of your keyboard)
and left-click the atom. Alternatively, simply click on a row in the spreadsheet. Note that table rows and atoms
in the graphics are linked, i.e., selecting one will automatically highlight the other. Click and drag your pointer
over a range of atoms while keeping the s -key of your keyboard is pressed to select more than one atom at
a time.

The spreadsheet can be used to visualize constraints (frozen coordinates), atom types, spin states, etc.
Simply sort the contents of the table columns that contain the relevant property (right-click on column header
cells >> Sort Ascending or Sort Descending ) and then select the block of atoms within the range of the
property you are interested in.

To export data from the spreadsheet (e.g., the atomic coordinates x, y, or z) into another spreadsheet program
such as Excel: right-click on the relevant column header >> Copy full column to save the data in the
clipboard of your computer. Afterward, paste the data into your favored spreadsheet program.

To copy data of only single spreadsheet cells: Click into the spreadsheet cell whose content should be
copied. Afterward, right-click in the cell >> Copy . . . . To paste data into one or several cells of the Atoms
Spreadsheet. Click into the spreadsheet cell whose content should be replaced by the copied data. In case
the content of other cells should be replaced, then click into other cells while pressing the Crtl key or Shift
key of the keyboard. These actions highlight cells in dark gray. Afterwords, right-click in the highlighted cells
whose content should be replaced >> Paste . . . .

6.6 Context Menu in the Periodic Structure Viewer

In general, the context menu of a periodic structure window is opened with a right-click somewhere in the
structure window. However, the displayed menu items depend on whether the pointer is positioned on an
atom, a bond, or empty space (anywhere else in the structure window), and whether structures have the
space group symmetry P1 or the symmetry of any other space group different from P1.

The following images show context menus for crystal structures which have the space group P1:

• Atom:
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• Bond:
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• Empty space:
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Transferring Atoms and Fragments Between Structures

With the following menu items, it is possible to transfer entities (single atoms, groups of atoms, molecules,
and fragments) from one structure into other structures.

• Paste : introduce previously copied atoms

• Copy full structure : creates a copy of the entire structure, including bond information, atom type, and
other atomic properties

• Copy selection : creates a copy of selected atoms of a structure, including bond information, atom
type, and other atomic properties

Action Modes

With the Mode : menu item changes the action mode between select, rotate, translate, and zoom (also
available from the MedeA icon bar)
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over a relevant region with atoms); selected atoms are highlighted in white

• Rotate : In this mode, the entire structure can be rotated

• Rotate selected atoms : In this mode only selected atoms of the structure can be rotated

• Translate : In this mode, the entire structure can be translated (moved)

• Translate selected atoms : In this mode only selected atoms of the structure can be translated (moved)

• Zoom : Zoom in/out by moving the pointer or using the arrow keys of the keyboard

• Select : Select atom(s) (by clicking on individual atoms or dragging the pointer over a relevant region
with atoms); selected atoms are highlighted in white

• Select Molecules : Select entire molecules and connected atoms, respectively (by clicking on individ-
ual atoms or dragging the pointer

• Drag Plane : Enable mode to move Miller planes with the pointer

Assign Forcefield Parameters

• Find Forcefield Atom Types : Assign forcefield (FF) atom types to all atoms based on the selected

forcefield (check the selected forcefield with the main menu item Forcefields >> Choose )

• Find Forcefield Charges : Assign forcefield (FF) charges to all atoms based on the selected forcefield

and assigned FF atom types (check the selected forcefield with the main menu item Forcefields >>

Choose )
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Selection of Atoms and Fragments

With the menu item Selection either select all atoms of a structure, clear atom selections, or modify struc-
tures based on the selected atoms.

Note: All the following items - except Select all (Crtl-A) - require previously selected atoms!

• Select all (Ctrl-A) : Selects all atoms; can be also invoked with the key-stroke Ctrl + A

• Attach fragments : bind atoms or molecules to previously selected atoms (more information is provided
in the Section Attach Fragments)

• Clear selection (Esc) : Unselect all atoms; can also be invoked with the Esc key of the keyboard

• Freeze selected atoms. . . : Sets structural constraints; useful for relaxations, molecular dynamics sim-
ulations, and selective vibrational analysis. By selecting a single axis the atom will only be frozen along
that axes.

By selecting Freeze All all the axes will be frozen.

You can unfreeze atoms by selecting none of the axes, or the Unfreeze All if axes are selected, and

clicking on the icon .

For more information see the description of the Freeze Atom Tab of the Crystal Builder )
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• Delete selected atoms (Del) : Erases selected atoms; can also be invoked with the Del key of the
keyboard

• Delete overlapping atoms : In case a copy of a selection of atoms is pasted into an existing structure,
then this option deletes all of the pasted atoms that are too close to any neighboring atoms of the newly
created structure.

• Extend selection by a bond : Expands the selection to neighboring atoms and atoms connected by
bonds

• Extend selection by a region : Expands the selection to atoms around the already selected atoms
independent on whether atoms are connected by bonds

– Mark the option Define one sphere for entire selection to set the center definition either as

* Geometrical center ,

* Center of mass , or

* Bounding box center (it is the center of an orthorhombic cell that encloses all selected
atoms)

– In case you mark the option Define one sphere per atom of the selection , then no other param-
eters need to be specified except the

– Radius: of the sphere

• Invert : select all un-selected atoms and de-select all previously selected atoms

• Find Forcefield Atom Types : Assign forcefield (FF) atom types to selected atoms only based on the

selected forcefield (check the selected forcefield with the main menu item Forcefields >> Choose )

• Simple Forcefield Dynamics : Evolves selected atoms in 100 molecular dynamics steps, employing a
simple forcefield

• Simple Forcefield Minimization : relaxes selected atoms, employing a simple forcefield

Note: The following three menu items appear only if a particular number of atoms are selected.

• Distance : Change the distance between two selected and connected (bonded) atoms

v. 3.9 Copyright © 2024 Materials Design, Inc., All rights reserved.
Materials Design® and MedeA® are registered trademarks of Materials Design, Inc.

12121 Scripps Summit Dr., Ste 160 San Diego, CA 92131

52 of 107



D
O

C
U

M
E

N
TA

TI
O

N
MedeA Documentation

• Angle : Change the angle between three selected and connected (bonded) atoms

• Dihedral : Change the torsional angle between four selected and connected (bonded) atoms

Note: All the following items require enabling the mixed visualization mode (click on icon )

• Display as CPK : visualize selected atoms as spheres

• Display as Ball & Sticks : visualize selected atoms as balls connected with sticks

• Display as Sticks : visualize selected atoms as sticks only

• Display as Lines : visualize selected atoms as lines

• Hide : do not show selected atoms

Subsets

Within MedeA subsets are sets of atoms that belong to particular molecules and fragments, are of the same
element, have the same forcefield atom type, are selected at the same time, etc. Subsets are very useful
and required to, for instance, graphically distinguish groups of atoms with different properties using different
visualization styles, to analyze results or post-process data of calculations. With the Subset context menu
item, you can create and edit subsets.

Note: All the following items - except Create. . . or Create subset from selection. . . require previously
created subsets or previously selected atoms.

v. 3.9 Copyright © 2024 Materials Design, Inc., All rights reserved.
Materials Design® and MedeA® are registered trademarks of Materials Design, Inc.

12121 Scripps Summit Dr., Ste 160 San Diego, CA 92131

53 of 107



D
O

C
U

M
E

N
TA

TI
O

N
MedeA Documentation

• Create. . . : opens the New tab of the Subset Manager to create a new subset based on atomic
properties

• Create subset from selection. . . : opens the New tab of the Subset Manager to create a new subset
based selected atoms

• Create subset from a connected pattern : opens the New tab of the Subset Manager to create a new
subset based on, e.g. a molecular structure

• Delete atoms in subset : Delete all atoms that form the subset and the subset itself

• Select atoms in subset : Select all atoms that define a subset

• Rename a subset : opens the Operate tab of the Subset Manager to change the name of an existing
subset

• Delete subset : Delete the subset definition but keep the atoms

• Combine subsets : opens the Operate tab of the Subset Manager to create a new subset by com-
bining two or more existing subsets

• Separate subset : opens the Operate tab of the Subset Manager to separate an existing subset

• Randomly filter subset : opens the Operate tab of the Subset Manager to randomly alter the number
of atoms of a particular subset

• Attach Fragments in subset : Connect molecular fragments of atoms to atoms of a subset (more infor-
mation is provided in the Section Attach Fragments)

• Convert subset : Convert a subset with the length 2 in a subset with the length 1. This menu item is
present only if a structure encompasses one or more subsets with a length larger than one.

• Subset summary : opens the Subsets tab of the Subset Manager summarize the properties of exist-
ing subsets

Edit Atom Properties

The Atom context menu item appears upon right-clicking with the pointer over an atom:
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The Edit option opens the Edit Atom tab of the Crystal Builder.

Create or Delete Bonds

Note: The following menu item only appears if the structure has bonds and if the right-click is invoked over
a bond.

• Delete bond. . . : Deletes the bond underneath the pointer

Note: The following menu item only appears if two atoms are selected.

• Create bond. . . : Create a bond between two previously selected atoms.

Modify Bond Order

Note: The following menu item only appears if the structure has bonds and if the right-click is invoked over
a bond.

With the menu item Bond Order you can change the order of the bond underneath the pointer

• Single : define a single bond

• Aromatic/Partial Double : Define an aromatic or partial double bond

• Double : Define a double bond

• Triple : Define a triple bond

Pre-optimize Positions of all Atoms
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• Simple Forcefield Dynamics : Evolves all atoms of a structure in 100 molecular dynamics steps, em-
ploying a simple forcefield

• Simple Forcefield Minimization : relaxes all atoms of a structure, employing a simple forcefield

Check Macromolecules

• Check for ring catenation : Determine whether molecule bonds/chains go through rings and loops of
other molecules (very important to avoid ring catenation, especially in realistic polymer models and
polyaromatic systems)

Edit Crystal Structures

• Edit Cell : Opens the Cell Tab of the Crystal Builder

• Edit Symmetry: Opens the Symmetry Tab of the Crystal Builder

• Edit bonds : Opens the Edit Bonds dialogue and lets you recalculate the bonds

• Add atom : Opens the Add Atom Tab of the Crystal Builder

Convert Periodic Structures Into Molecules and Clusters

• Create a non periodic copy : Transfers the structure to the Molecular Builder without periodic bound-
ary conditions

Tag Atoms With Labels

With the menu item Atom labels define in sub-menus which atomic properties should be displayed as labels
next to each atom
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• Atomic number : Display the atomic number of the atoms

• Calculated charge : Display the charge that was calculated with e.g. VASP

• Atomic symbol : Display element symbol

• Forcefield atom type : Display assigned forcefield atom type

• Forcefield charge on atom : Display assigned forcefield atom charge

Note: Forcefield atom type and Forcefield charge on atom only appear after forcefield atom types
and forcefield charges have been assigned. See Assign Forcefield Atom Types for more details

• Fractional coordinates : Display fractional coordinates of atoms

• Name : Display global index of atoms

• Name : Display assigned name of atoms

• Number of bonds : Display number of connections to other atoms

• Point : Display point of atoms

• Site : Display crystallographic site of atoms within the assigned space group symmetry

• Spin : Display magnetic moment of the atoms
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• Symmetry parent : Display the symmetry parent of the atoms

• Wyckoff position : Display crystallographic Wyckoff position of atoms within the assigned space group
symmetry

6.7 Display Miller Planes

To display Miller planes, right-click >> Add a Miller plane . Miller planes are defined by their indices h , k ,

and l (see also Miller Index [6]).

Examples

A Miller plane with any value for h yields a plane that is orthogonal to the x-axis. A (120) Miller plane is
orthogonal to the vector (x=1, y=0.5) and parallel to z

Structures can be displayed with more than one Miller plane, as shown in the above image.

Miller planes can be translated when the icon is toggled, i.e. when the Drag Plane mode is enabled. The
Drag Plane mode can be also enabled via the context menu: right-click in the structure viewer >> Mode
>> Drag Plane . If the Drag Plane mode is enabled then Miller planes can be translated by dragging with
the pointer.

Visualize Miller planes via right-click >> Add a Miller plane .

7 Empty Space Finder

7.1 Introduction

With the MedeA’s Find Empty Space, aka Empty Space Finder, you can analyze structures in a periodic
simulation cell (e.g. crystal structures) regarding empty (interstitial) space in which atoms or molecules can
be located. The Empty Space Finder algorithm divides the cell into so-called Voronoi cells around each atom.
A Voronoi cell is defined to be the volume enclosing all points that are closer to the central atom than to all
other atoms.

The Empty Space Finder module positions non-overlapping spheres at the vertices of the resulting polyhedral
grid and maximizes their radii. In doing so the physical size of different atomic species is taken into account

[6] http://en.wikipedia.org/wiki/Miller index
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through a set of covalent radii (currently fixed). Note that the MedeA Empty Space Finder changes the sphere
size to make them non-overlapping [7].

7.2 Empty Space Finder Features

The following features are available for the Empty Space Finder:

• Find and display the largest possible void spheres on the vertices of a Voronoi mesh

• Display local coordination and symmetry of voids

• Insert atoms on void centers

• Hide/display all/selected voids

• Sort void table by radius, site ID, symmetry, etc.

7.3 Empty Space Finder Usage

To use the Empty Space Finder activate a structure window that contains a periodic structure and invoke
Edit >> Find empty space. . . . Depending on the size of the structure and the symmetry the structure

window splits into two parts within a few seconds (in case of structures with more than 500 atoms the entire
process can also take several minutes). The left part displays the structure together with colored translucent
spheres where the Empty Space Finder has found empty space. Crystallographically identical voids are
displayed in the same color. The right panel displays a table with the properties of the translucent spheres.

Each sphere is characterized by

• an ID

• a Radius

• a Site id

[7] C Bradford Barber, David P Dobkin, and Hannu Huhdanpaa, “The Quickhull Algorithm for Convex Hulls,” ACM Transactions on
Mathematical Software 22, no. 4 (December 1, 1996): 469-483.
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• a Symmetry label

• a Coordination

• the fractional X , Y , and Z coordinates

As in other tables used within MedeA the table content and, hence, the sphere properties can be sorted in as-
cending or descending order. Simply right-click on one of the header column cells (e.g. that for Coordination )
>> Sort Descending .

You can hide or show individual spheres by clicking into one of the table rows (to highlight), followed by
right-click >> Hide spheres and right-click >> Show spheres , respectively.
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To hide all spheres and show all spheres again use the relevant buttons Hide all and Show all , respectively,
which are located beneath the table.

To reduce the number of spheres that are considered and shown, adjust the values for the options Minimum
radius: and Maximum radius: followed by a click on Recalculate .

• Minimum radius: Gives a lower threshold for the void radius. No voids with radii smaller than the
minimum radius will be shown in the table.

• Maximum radius: Upper threshold for the void radius. No voids with radii larger than the maximum
radius will be shown in the table.

If you want to insert an atom onto the center of a sphere:

1. Choose the Insertion element from the upper right corner with the entry box or the icon with the
periodic table:

2. Right-click onto the relevant row in the table >> Insert atom

To close the Empty Space Finder and return to the original structure window click on the icon .

8 Strain the Structure

With Edit >> Strain the structure. . . you can deform the simulation cell of a periodic structure
by applying a general engineering strain, provided the space group is P1:
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Hint: To apply an engineering strain, lower the symmetry of the structure to P1 with right-click >>

Edit Symmetry. . . . For more information see Section Symmetry Tab

In the dialogue, set the six independent elements of the dimensionless engineering strain (xx, yy, zz, and yz,

xz, xy ) and apply the chosen strain with a click on the icon . Close the dialogue with a click on the icon

.

Hint: A value of 0.15 means tensile stress of 15.0% and a value of -0.1 means compressive stress by
10%.

An alternative way to strain crystal structures is to change their cell parameters (length and angle) via the
Cell Tab of the Crystal Builder which can be opened with right-click >> Edit Cell. . . .

9 Edit Bonds

Information about bonds (interatomic connections) is essential for force field (FF) methods (LAMMPS and
GIBBS), and very useful for creating and understanding structures for VASP, MOPAC, and Gaussian.
Bonds can be created and deleted with the Bond Editor dialogue which can be invoked from Edit >>

Edit bonds. . . or right-click >> Edit bonds. . . .

To create bonds, two algorithms are available: the fast bonding algorithm and the coordination algorithm. The
fast bonding algorithm considers bonded all atom pairs whose distance is lower than the sum of their covalent
radii, multiplied by the bond factor. The coordination algorithm is more time demanding (and is recommended
for small structures) and comprises two steps:

1. All neighboring atoms that are not Voronoi neighbors are excluded. Voronoi cells are defined around
each atom, as the portion of space where each point is closer to that atom than any other. Atomic
extents are defined by covalent radii, and this Voronoi analysis provides a superior criterion for neighbor
selection when a structure contains species with differing atomic radii (owing to the fact that if the
segment from a particular atom to a neighboring atom intersects the Voronoi cell of a third atom, that
potential neighbor can be discarded).

2. Reduced distances between an atom and its neighbors are computed as the distance divided by the
sum of covalent radii. The largest gap in the neighbors’ reduced distances distribution is considered
to separate nearest neighbors from further neighbors, and this criterion is employed to detect nearest
neighbors.

When two atoms are determined to be nearest neighbors, a bond is created, if the reduced distance is below
the supplied cutoff factor. On occasion an atom A can consider an atom B as a nearest neighbor, but B would
not consider A as such: in such cases no bond is created between A and B.

The minimum gap parameter controls the quality of the closest neighbor choice. If the maximum gap that
can be found in the reduced distances distribution is lower than the gap value provided, no clear indication of
neighbors can be found using this criterion and all Voronoi neighbors below the cutoff value are accepted as
neighbors.
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• Remove all bonds : delete all bonds between atoms; the result is a structure with spheres only

• Bond cutoff factor : Two atoms closer than the sum of their covalent radii multiplied by the dimension-
less Bond cutoff factor are considered to be nearest neighbors and a bond is created

• Minimum Gap : MedeA uses Voronoi tessellation to find nearby atoms without considering atoms in

higher coordination shells. You can still add a small value defined by this option (value in Å) to discern
first and second coordination shells

• Use fast bonding : With this option fast bonding algorithm is used, otherwise the coordination algorithm
is employed.

• Keep active bonds : This option is available only for non-periodic (e.g. molecular) structures and en-
abled by default to avoid the deletion of active bonds. The latter are stubs or “half” bonds of atoms
which are good to semi-automatically add hydrogen atoms or other selected fragments. Disable this
option to also delete all active bonds.

• Calculate bond orders : when this check box is checked bond orders are determined for elements
found in typical organic structures. These are C, N, O, F, Si, P, S, Cl, Ge, Br and I

• Reset all bonds : Delete all existing bonds and compute new bonds according to the defined Bond
cutoff factor and Minimum Gap. All extra information about bonds will be lost (bond orders for example)

• Complete bonds : Keep existing bonds (including bond orders, the main interest of this option) and
compute and create other missing bonds that are following the defined parameters

• Complete and delete invalid bonds : Delete existing bonds that are not valid according to the defined
parameters, but keep all other existing bonds (including bond orders, the main interest of this option)

Hint: In case a structure has too many bonds start by reducing the Bond cutoff factor in small steps, until
you find an appropriate number of bonds, confirm intermediate steps with Apply and close the dialogue

window with OK .

Confirm modifications with Apply .
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10 Rename Structures

To distinguish and recognize structures swiftly and to keep the overview you might want to give structures
distinct names. You can do that for an active structure using Edit >> Rename .

Simply enter a meaningful name and confirm with OK . The new name appears immediately in the title bar
of the structure window.

11 Automatically Rename Atoms

Whenever structures are imported from external resources, e.g. as VASP POSCAR files via File >>

Open structure from disk , all atoms can have the same names:
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You can give all atoms different and distinguishable names using Edit >> Automatically rename atoms .
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12 Create Copies of Structures

While building structures it is quite useful to keep copies of a structure before continued editing of the system.
Creating copies of structures is sometimes also useful in case final structures have the same origin, i.e. the
same parent structure.

Simply copy active structures via Edit >> Duplicate .

13 Molecular Builder

The MedeA Molecular Builder lets you create molecules, fragments, and polymer repeat units from scratch
and combine them with bulk and/or surface systems. The resulting structures are created for use with the
MedeA compute engines VASP, GIBBS, LAMMPS, MOPAC, and Gaussian.
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Besides, you can use and expand a library of molecular fragments which are very useful building blocks when
constructing more complex systems. Furthermore, you can predict particular thermophysical properties of
small molecules and polymer repeat units with QSPR and P3C, respectively, i.e. based on group contribution
and topological descriptor methods.

13.1 Getting Started

You can start the Molecular Builder without any active system via

• using the keyboard shortcut Crtl + m

• invoking File >> New non periodic structure

• invoking File >> New molecule from SMILES (for more information see Create New Structures)

Alternatively, you can also transform active periodic structures into molecular (non-periodic) structures via

• Edit >> Create a non periodic copy

• right-click >> Create a non periodic copy

The Molecular Builder consists of a drawing area (canvas on the left) and the six tabs

• Insertion

• References

• Cell

• Charge/Spin

• P3C

• QSPR

To display a specific tab, simply click on the tab with the appropriate label.

Hint: If the right-side tools panel does not appear, hover your mouse to the upper right corner of the active

window and click the Select side panel icon :

Then choose the Molecular builder panel:
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13.2 Main Features in Brief

As you start building, the drawing area displays the structure under construction. A right-click into a blank
spot of the drawing area invokes the Context Menu in the Molecular Builder

When adding atoms to build up the molecule, the title bar of the Molecular Builder window displays the current
stoichiometry of the active structure. An asterisk (*) indicates that you made changes to the structure but did
not save these changes.

To start building a molecule from scratch, click on an element and coordination icon in the Insertion tab. In
doing so you “load” your pointer with the selected element and the shape of the pointer turns into a pencil.
When the pointer has been loaded, click somewhere in the canvas to deposit an atom, connect atoms through
their active bonds (stubs), or move the pointer over one of the existing bonds to highlight the bond in purple,
followed by a click to drop an atom, thereby creating a bond.

To load the pointer with a fragment, click on Fragments and select a fragment from the groups

• Amino acid side chains

• Fatty acids

• Functional groups

• Hydrocarbons,

• Ligands

• Rings

Once the pointer is loaded with a fragment it has the shape of a pencil. With the pencil pointer, click some-
where in the canvas to deposit the selected fragment.

Note: One atom of the deposited fragment has an active bond which appears as a stub.

After you have modified the fragment you can save this fragment, with the Context Menu: right-click some-
where in the drawing area >> Save as Fragment .

Note: To save molecules as fragments they must have one active bond.
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In case molecules do not have any active bond you can add one simply by right-clicking on the atom that
should have an active bond >> Atom >> Add Active Bond .

Fragments, i.e. molecules with one active bond, and also molecules with more active bonds can be easily
connected with other atoms and fragments. To connect fragments with another atom, first select an
element and a Coordination from the Insertion tab, then move the pencil pointer over the active bond
(should turn into purple), and finally, click on the purple bond. Depending on the selected element and
coordination, the added atom has zero, one, or more extra active bonds to connect with other atoms and
fragments.

To connect fragments with another fragment, first select a fragment via the Fragments selection bar of the

Insertion tab, then move the pencil pointer over the active bond (should turn purple), and finally, click on the
bond.

Note: Moving the pointer holding down the left pointer key lets you rotate the added fragment around the
newly formed bond.

The options and features to position and visualize structures are almost identical to those described in the
Section Structure Positioning and Visualization. Relevant features are accessible via the View menu in the
main menu bar and the icon bar below the main menu bar.

The created molecular structures can be used directly to start MedeA jobs with the MOPAC GUI and the
Gaussian GUI. The features of the MOPAC GUI and the Gaussian GUI are described in the manual Sections
MOPAC 2009/2012/2016 and MedeA Gaussian, respectively.

Hint: Every structure used to start a MedeA job is automatically stored on the JobServer and can be opened
via File >> Open structure from job .

It is also possible is to save molecular structures in structure lists. Saving structures in structure lists is
described in chapter MedeA HT of the MedeA manual.

In case you want to save a structure as a file to disk, export a molecule with File >> Export to file The

supported file formats are visible in the selection bar Files of type: .
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The supported structure file formats are

• SciCo Files (*.sci): the native format of MedeA

• XMol Files (*.xyz, *.xmol): write files that contain a line with the number of atoms 𝑛, then by a title line,
followed by 𝑛 lines with four columns each with the element symbol, and the three spacial Cartesian
coordinates; cell parameters are completely omitted

• Mol Files (*.mol): structure data stored in the mol format the files can also contain cell parameters

• PDB Files (*.pdb): structure data stored in the format of the Protein Data Base archive

• Bitmap (*.bmp): pixel image in the Windows bitmap format

• PNG (*.png): pixel image in the portable network graphics format

• SVG (*.svg): scalable vector graphic image

• TIFF (*.tiff): pixel graphic in the tagged image file format

Note: All other file format that are listed in the selection for Files of type: cannot be used to save non-
periodic structures on disk.
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To convert a molecular structure without periodic boundary conditions back to a periodic system invoke Edit
>> Create a periodic copy .

Hint: MedeA jobs with VASP, LAMMPS, and GIBBS require structures in simulation cells, i.e. with periodic
boundary conditions.

13.3 Context Menu in the Molecular Builder

In general, the context menu of a molecular structure window is opened with a right-click somewhere in the
drawing area. However, the displayed menu items depend on whether the pointer is positioned on an atom,
a bond, or empty space (anywhere else in the structure window).

Transferring Atoms and Fragments Between Structures

With the following menu items, it is possible the transfer entities (single atoms, groups of atoms, molecules,
and fragments) from one structure into other structures.

• Paste : introduce previously copied atoms

• Copy full structure : creates a copy of the entire structure, including bond information, atom type, and
other atomic properties

• Copy selection : creates a copy of selected atoms of a structure, including bond information, atom
type, and other atomic properties

Descriptions of all other items of the context menu are as follows:

Modify Internal Coordinates

With the Internal coordinates menu item you can interactively change the internal coordinates of molecules
such as dihedrals (torsional angles), bond angles, and bond lengths.
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Note: This menu item appears if a structure has at least four atoms.

Either use the sliders to reduce or increase the values of particular coordinates one-by-one. Alternatively,
enter the new values in the number fields; the units are Å for distances and degrees for angles. Molecular
structures immediately respond to the changes. Add or remove certain internal coordinates with the selectors
+ and - , respectively. Internal coordinates that cannot be modified independently, i.e. without affecting

other internal coordinates due to structural restrictions, are highlighted in red.

To confirm all modifications, close the dialogue with OK . To discard all structural modifications, close the
dialogue with Cancel .

Hint: To reset all structural modifications in case the dialogue was accidentally closed with OK click on the
Clean button of the Insertion tab.

Other features of the Molecular Builder used to modify internal coordinates of molecules require selected
atoms.

Note: The following three menu items appear only in the main context menu if a particular number of atoms
is selected.

• Distance : Change the distance between two selected and connected (bonded) atoms
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• Bond Angle : Change the angle between three selected and connected (bonded) atoms

• Dihedral : Change the torsional angle between four selected and connected (bonded) atoms

Action Modes

With the Mode menu item changes the action mode.

• Rotate : In this mode, the entire structure can be rotated

• Rotate Selection : In this mode only selected atoms of the structure can be rotated

• Translate : In this mode, the entire structure can be translated (moved)

• Translate Selection : In this mode only selected atoms of the structure can be translated (moved)
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• Zoom : Zoom in/out by moving the pointer or using the arrow keys of the keyboard

• Select : Select atom(s) (by clicking on individual atoms or dragging the pointer over a relevant region
with atoms); selected atoms are highlighted in white

• Select Molecules : Select entire molecules and connected atoms, respectively (by clicking on individ-
ual atoms or dragging the pointer over a relevant region with atoms); selected atoms are highlighted in
white

Position all Molecules in the Drawing Area

With the menu item All collectively move all molecules, fragments, atoms, etc. that are present in the
drawing area of the Molecular Builder

• Center to origin : Move the common center of mass of all structures to the center of the coordinate
system, i.e. x = y = z = 0.0 (the center of the coordinate system can be visualized with the axes icon

and is at the intersection of the colored cylinders

• Center to reference point : Move the common center of mass of all structures to a reference point that

is defined in the References tab of the Molecular Builder.

Selection of Atoms and Fragments

With the menu item Selection either select all atoms of a structure, clear atom selections, or modify struc-
tures based on the selected atoms.

Note: All the following items - except Select all (Crtl-A) require previously selected atoms!
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• Select all (Ctrl-A) : Selects all atoms; can be also invoked with the key-stroke Ctrl + A

• Attach fragments : bind atoms or molecules to previously selected atoms (more information is provided
in the Section Attach Fragments Tab)

• Clear selection (Esc) : Unselect any selection; can be also invoked with the Esc key of the keyboard

• Center to reference point : Move the common center of mass of the selected atoms to a reference

point that is defined in the References tab of the Molecular Builder

• Delete selected atoms (Del) : Erases selected atoms and bonds to connected atoms; can be invoked

with the Del key of the keyboard

• Delete selected atoms only : Erases selected atoms but maintains half bonds as stubs (active
bonds) to connect other atoms or fragments

• Delete overlapping atoms : In case a copy of a selection of atom is pasted into an existing structure,
then this option deletes all atoms of pasted atoms that are too close to any neighboring atom of the
existing structure.

• Extend selection by a bond : Expands selection to neighboring atoms and atoms connected with
bonds

• Extend selection by a region : Expands the selection to atoms around the already selected atoms
independent on whether atoms are connected by bonds

v. 3.9 Copyright © 2024 Materials Design, Inc., All rights reserved.
Materials Design® and MedeA® are registered trademarks of Materials Design, Inc.

12121 Scripps Summit Dr., Ste 160 San Diego, CA 92131

75 of 107



D
O

C
U

M
E

N
TA

TI
O

N
MedeA Documentation

– Mark the option Define one sphere for entire selection to set the center definition either as

* Geometrical center ,

* Center of mass , or

* Bounding box center (it is the center of an orthorhombic cell that encloses all selected
atoms)

– In case you mark the option Define one sphere per atom of the selection , then no other param-
eters need to be specified except the

• Invert : select all un-selected atoms and de-select all previously selected atoms

• Rotate selection : Rotate selected atoms around the Reference vector which is defined in the
References tab of the Molecular Builder The units of rotation angles are degrees.

• Translate selection : Translate selected atoms parallel to the Reference vector which is defined in
the References tab of the Molecular Builder ; the translation distance is defined by the length of the
Reference vector

• Simple Forcefield Dynamics : Evolves selected atoms in 100 molecular dynamics steps, employing a
simple forcefield

• Simple Forcefield Minimization : relaxes selected atoms, employing a simple forcefield

Note: The following menu items appear only if a particular number of atoms are selected.

• Define repeat unit : If two non-hydrogen atoms are selected you can set the head and tail of a repeat
unit (polymer ‘monomer’) that you can then use in the Polymer Builder to create macromolecules

• Reverse repeat unit head and tail : If the head and tail atoms of a repeat unit are selected swap the
head and tail of the repeat unit

• Set connecting dihedral angles : Modify all torsional angles between two selected atoms. Requires
that the two selected atoms are separated by two or more other atoms.

Note: This is a very useful feature to set torsional angles in a polymer chain or any other large
molecule.

• Set as reference vector : Define a reference vector with two selected atoms; reference vectors are
useful to translate and rotate selected atoms along a certain direction and around a particular axis
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• Set normal as reference vector : If you have selected three atoms, then define a reference vector as
the normal of the surface that is spanned by the three atoms; reference vectors are useful to translate
and rotate selected atoms along a certain direction and around a particular axis

Note: All the following items require enabling the mixed visualization mode (click on the icon )

• Display as CPK : visualize selected atoms as spheres

• Display as Ball & Sticks : visualize selected atoms as balls connected with sticks

• Display as Sticks : visualize selected atoms as sticks only

• Display as Lines : visualize selected atoms as lines

• Hide : do not show selected atoms

Subsets

Within MedeA subsets are sets of atoms that belong to particular molecules and fragments, are of the same
element, have the same forcefield atom type, are selected at the same time, etc. Subsets are very useful
and required, for example, to graphically distinguish groups of atoms with different properties using different
visualization styles, to analyze results, or to post-process data from calculations. With the Subset context
menu item you can create and edit subsets. ::itcl::delete object $gp .. note:

All the following items - except :highlightgray:`Create...` or
→˓:highlightgray:`Create subset from selection...`
require previously created subsets or previously selected atoms.
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• Create. . . : opens the New tab of the Subset Manager to create a new subset based on atomic
properties

• Create subset from selection. . . : opens the New tab of the Subset Manager to create a new subset
based selected atoms

• Create subset from a connected pattern : opens the New tab of the Subset Manager to create a new
subset based on, e.g. a molecular structure

• Delete atoms in subset : Delete all atoms that form the subset and the subset itself

• Select atoms in subset : Select all atoms that define a subset

• Rename a subset : opens the Operate tab of the Subset Manager to change the name of an existing
subset

• Delete subset : Delete the subset definition but keep the atoms

• Combine subsets : opens the Operate tab of the Subset Manager to create a new subset by com-
bining two or more existing subsets

• Separate subset : opens the Operate tab of the Subset Manager to separate an existing subset

• Randomly filter subset : opens the Operate tab of the Subset Manager to randomly alter the number
of atoms of a particular subset

• Attach Fragments in subset : Connect molecular fragments of atoms to atoms of a subset (more infor-
mation is provided in the Section Attach Fragments)
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• Convert subset : Convert a subset with the length 2 in a subset with the length 1. This menu item is
present only if a structure encompasses one or more subsets with a length larger than one.

• Subset summary : opens the Subsets tab of the Subset Manager summarize the properties of exist-
ing subsets

Edit Atom Properties

The Atom context menu item appears upon right-clicking with the pointer over an atom

• Add Active Bond. . . : Add a half bond (stub) to an atom; the direction of the bond is perpendicular to
the screen

• Center this atom to origin : Move the atom and all connected atoms to the center of the coordinate
system, i.e. x = y = z = 0.0 (the center of the coordinate system can be visualized with the axes icon

and is the intersection of the colored cylinders

• Center this atom to reference point : Translate this atom and all connected atoms to a reference point

that is defined in the References tab of the Molecular Builder

• Change atom element : Replace the element of this atom with the element selected in the periodic

system of the elements in the Insertion tab; the selected coordination is ignored

• Delete atom only : Delete this atom but maintain the half bonds (stubs) of the connected atoms as
active bonds

• Delete atom : Delete this atom and all bonds to connected atoms

• Move this atom to reference point : Move only this atom (not the other atoms) to a reference point that

is defined in the References tab of the Molecular Builder
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Hint: To place the center of mass of a molecule at the center of the simulation box, first com-
pute the Center of mass in the Reference tab, then multiply it by -1 and then right-click and select
All >> Center to Reference point will center the center of mass of the molecule to the center of the box.

Edit Molecule Properties

The Molecule context menu item appears upon right-clicking with the pointer over an atom

• Center to reference point : Translate the center of mass of this molecule to a reference point that is

defined in the References tab of the Molecular Builder

• Delete : Delete this molecule

• Select molecule : Select this entire molecule

• Unselect molecule : Clear selection of this entire molecule entirely

• Rotate : Rotate this molecule around the Reference vector which is defined in the References tab
of the Molecular Builder

The unit of the rotation angle is degrees.

• Translate : Translate this molecule parallel to the Reference vector which is defined in the
References tab of the Molecular Builder ; the translation distance is defined by the length of the
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Reference vector

Create or Delete Bonds

Note: The following menu item only appears if the structure has bonds and if the right-click is over a bond.

• Delete bond. . . : Deletes the bond underneath the pointer

Note: The following menu item only appears if two atoms are selected.

• Create bond : Create a bond between two selected atoms.

Modify Bond Order

Note: The following menu items only appear if the structure has bonds and if the right-click is over a bond.

With the menu item Bond Order you can change the order of the bond underneath the pointer

• Single : Define a single bond

• Aromatic/Partial Double : Define an aromatic or partial double bond

• Double : Define a double bond

• Triple : Define a triple bond

Check Macromolecules

• Check for ring catenation : Determine whether molecule bonds/chains go through rings and loops of
other molecules (very important to avoid ring catenation, especially in realistic polymer and polyaro-
matic models)

Create Periodic Structures

• Create periodic copy : Put all molecules, fragments, atoms, etc. in the drawing area in a simulation
cell with periodic boundary conditions, such that the resulting structure can be used in calculations with
VASP, LAMMPS, and GIBBS; the cell dimensions are defined in the Cell tab of the Molecular Builder

• Edit bonds : Opens the Edit Bonds dialogue and lets you recalculate the bonds

Tag Atoms With Labels
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With the menu item Atom labels define in sub-menus which atomic properties should be displayed as labels
next to each atom

• Atomic number : Display the atom index in the structure

• Calculated charge : Display the charge that was calculated with e.g. VASP

• Atomic symbol : Display element symbol

• Name : Display assigned name of atoms

• Number of bonds : Display number of connections to other atoms

• Point : Display points of atoms

• Spin : Display magnetic moment of atoms
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13.4 Insertion Tab

Within the insertion tab, you can select elements to add to structures in the drawing area and their coordina-
tion. When selecting an element, its default coordination is highlighted in the Section Coordination:

Example: For Oxygen, the default coordination of 2 is highlighted. You can change the coordination by
selecting, e.g. 1

An element with coordination number 𝑛 will be drawn with 𝑛 active bonds. Note that an active bond is just
a visual aid (depicted as a stub) serving to make a connection to other atoms. Using active bonds you can
build up realistic molecular structures with a few pointer clicks.

Hint: A structure with at least one active bond is considered to be a fragment. A fragment can be saved
to the fragment library for later reuse as a molecular building block. A molecular structure without any active
bonds is considered a complete molecule. To save a molecule, export it to disk or convert it into a periodic
model.

Further features present in the Insertion tab are:

• Fragments : With this selector you access to about 100 different fragments which are categorized into

amino acid side chains , fatty acids , functional groups ; hydrocarbons , ligands , and rings .
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– User fragments : With this selector, you have access to your fragment library

Any fragment (a molecule with one active bond) in the drawing area can be added to your fragment library
with the context menu (right-click >> Save as fragment )

With a click on a record in the list of fragments, you select a fragment. To load the pointer with this frag-
ment confirm with OK . You can also Delete the highlighted fragment, Import a library from a file , and

Export library to file . With the latter two options, you can share fragment libraries with colleagues, e.g.
transferring custom fragments between MedeA installations.

• Hydrogenate : With this option automatically add hydrogen atoms to all active bonds

• Passivate Saturate all active bonds with the element that is activated in the periodic system of the
elements or an active fragment.

• Clean : This option relaxes molecular structures with a simple forcefield to obtain a reasonable initial
structure for further modifications or calculations.

• Clean selection : This option relaxes only selected atoms in the drawing area with a simple forcefield.

Note: Molecules are relaxed based on the chemical connectivity and a forcefield that combines generic
non-bonded interactions (Lennard-Jones potential) with atom-specific parameters for bonds, angles,
and dihedrals.

13.5 References Tab

The References panel lets you define a reference point and a reference vector to perform actions such as
Translate , Rotate , Center single atoms, a group of selected atoms, individual molecules, or all molecules

in the drawing area.
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For example, you can define a reference point to be the center of mass of the molecule or a selection of
atoms. You can then translate the molecule such that its geometrical center comes to lie on the center of
mass. Alternatively, you can define a reference point and vector and translate a group of atoms or a molecule
around the axis defined by the point and vector.

Reference point

You can type in the values for the x: , y: , and z: coordinates of a point (press the Return key of the
keyboard to confirm) or select special points from the list:

• Geometrical center : geometrical center of all atoms in the drawing area

• Center of Mass : center of mass of all atoms in the drawing area

– Bounding box center : center of the smallest possible orthorhombic box that encompasses all
atoms

• Selection geometrical center : geometric center of the selected atoms

• Selection center of mass : center of mass of the selected atoms

• Selection bounding box center : center of the smallest box that encompasses all selected atoms

To set the new reference point click on Compute .

Reference vector

To define a vector, simply input values for the x: , y: , and z: coordinates of the end point of the vector.
The offset or starting point of the vector is defined by the reference point. Alternatively you can select two
atoms in the drawing area and invoke right-click >> Selection >> Set as reference vector . The values of
the x: , y: , and z: coordinates for the reference point and reference vector are adapted accordingly. Also,

you can scale the vector by setting Multiply by to a value other than 1.0.

Check the box Show References to display the reference point and vector (red bullet and red cylinder in
drawing area).

Hint: Note that atoms or bonds may hide the reference point and vector.
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13.6 Cell Tab

In the Cell tab defines the dimension of the cell that surrounds the molecules in the drawing area. When
converted to a periodic structure this cell will be the periodic unit cell and simulation cell in which structures
are located.

When converting a periodic structure into a molecular structure the original cell parameters are maintained
and shown by default.

However, you can either explicitly define the cell parameters a: , b: , c: , alpha: , beta: , and gamma: .

Alternatively, define a void region (a value for the option a cell leaving a gap of ) around the molecules and

leave it to the builder to handle cell dimensions by clicking on Compute .

To show the current cell add a check-mark to the option Show Cell .

If you want to convert a structure to a periodic model click on Create a periodic copy .

13.7 Charge/Spin Tab

The Charge/Spin tab allows you to set the total charge and spin of a system used in calculations with
MOPAC and Gaussian.
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The total charge is expressed in units of electrons and the spin is expressed via the spin multiplicity, 2𝑆 + 1,
whereby 𝑆 is the angular spin momentum. For a given value of 𝑆 the spin multiplicity determines the number
of degenerate wavefunctions which differ only in the orientation of their angular spin momenta.

13.8 P3C Tab

This tab displays thermo-physical properties and structural descriptors that are calculated with MedeA P3C
(Polymer Property Prediction using Correlations). This approach employs correlations to predict polymer
properties based on the chemical topology of its constituent repeat units.

More information is provided in Section MedeA P3C:Polymer Property Prediction Using Correlations.

13.9 QSPR Tab

This tab displays thermo-physical properties and structural descriptors that are calculated with MedeA QSPR
(Quantitative Structure Property Relationships). The approach employs correlations based on the chemical
groups that constitute an organic molecule.
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More information is provided in Section MedeA QSPR: Property Prediction Using Group Contributions

14 Attach Fragments

Using the Attach Fragments dialogue you can quickly attach atoms and molecular fragments to atoms of
amorphous and crystalline bulk structures, surface atoms of slab models, clusters, etc.

The Attach Fragments dialogue is also accessible via the context menu items

• Subsets (see menu item Selection)

• Selection (see menu item Subsets)
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A requirement to attach fragments is that atoms, to which other atoms or molecular fragments should be
attached, must either be selected or part of subsets.

The first line in the Section Fragment selection: indicates the number of atoms to which fragments will be
attached. For example, in the above screenshot, the line is 24 selected atoms , which implies that one
fragment will be attached to 24 atoms of the active structure.

With atoms selected, choose the fragment that should be attached from the Fragments: selection bar. The
fragment library consists of about 100 different molecular residuals which are categorized into

• Amino acid side chains

• Fatty acids

• Functional groups

• Hydrocarbons,

• Ligands

• Rings

and also User defined fragments.

The selected fragment is displayed in the small image next to the Fragments: selection bar. To min-
imize steric repulsion between the attached fragments and the host structure, tick (enable) the option
Relax attached fragments . In case you want to avoid any overlap among added fragments and with the

host structure tick (enable) the option Dismiss overlapping fragments .

With the options in the Direction: Section you can attach fragments such that their backbone is parallel to
an Explicit: spatial direction defined by the vectorial components x: , y: , and z: . However, by default, the

direction of the backbones of fragments is automatically defined by the algorithm of the Attach Fragments
feature.

The most general case is that only the option No handle of active bonds is enabled. With this option, only
one fragment is attached to each selected atom. In molecular (non-periodic) structures atoms can have one
or more active bonds (stubs without any connections to other atoms). In such cases the other two options

• Attach on one active bond

• Attach on each active bond

can be checked (enabled). The first option of the two implies that among several active bonds of the selected
atoms a fragment is attached to only one active bond. If the second option is enabled then fragments are
attached to all active bonds of the selected atoms.

With the options in the Selection: Section you can define whether to maintain the initial selection of the
atoms to which atoms are attached ( keep the initial selection ) or to extend the selection to the atoms of the

attached fragments ( Add fragments to the selection ).

As illustrated in the image below, the feature Attach Fragments lets you attach water molecules to atoms of
the two images of a slab model for the Al2O3 (001) surface with four steps:

1. Select relevant atoms to which water molecules should be attached

2. Right-click >> Selection >> Attach fragments

3. Choose water from the fragment library ( Fragments >> ligands >> water )

4. Confirm with OK
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15 Mesoscale Builder

The MedeA Mesoscale Builder lets you create mesoscale structures and polymer repeat units from scratch
and combine them with bulk and/or surface systems. The resulting structures are created for use with the
MedeA compute engines GIBBS and LAMMPS.

15.1 Getting Started

You can start the Mesoscale Builder without any active system via

• invoking File >> New mesoscale molecule

Alternatively, you can also transform active periodic mesoscale structures into non-periodic mesoscale struc-
tures via

• Edit >> Edit in mesoscale builder

• right-click >> Edit in mesoscale builder

The Mesoscale Builder consists of a drawing area (canvas on the left) and the three tabs

• Insertion

• References

• Cell

To display a specific tab, simply click on the tab with the appropriate label.

15.2 Main Features in Brief

As you start building, the drawing area displays the mesoscale structure under construction. A right-click into
a blank spot of the drawing area invokes the Context Menu in the Mesoscale Builder .

When adding beads to build up the mesoscale system, the title bar of the Mesoscale Builder window displays
the current stoichiometry of the active structure. An asterisk (*) indicates that you made changes to the
structure but did not save these changes.

To start building a mesoscale system from scratch, select a bead from a bead family in the Insertion tab. In
doing so you “load” your pointer with the selected bead, the shape of the pointer turns into a pencil and the
properties of the bead are displayed beneath the table of beads in the Insertion tab. Click somewhere in

v. 3.9 Copyright © 2024 Materials Design, Inc., All rights reserved.
Materials Design® and MedeA® are registered trademarks of Materials Design, Inc.

12121 Scripps Summit Dr., Ste 160 San Diego, CA 92131

90 of 107



D
O

C
U

M
E

N
TA

TI
O

N
MedeA Documentation

the canvas to add a bead. The bead added will automatically be selected. By clicking again in the canvas
another bead will be added which is connected to the first bead and the selection moves to the new bead.
This way you can draw a chain of beads by just repeatedly clicking on the canvas. To connect the new bead
to another bead change the selection as required using the selection mode. If you click on an existing bead
a bond to this bead will be created, but no new bead will be added. You can easily close rings using this
functionality.

In case mesoscale systems do not have any active bond you can add one simply by right-clicking on the
bead that should have an active bond and choosing Bead >> Add Active Bond from the menu popping
up. Active bonds might be required for defining repeat units for constructing polymers.

The options and features to position and visualize mesoscale structures are identical to those described in
the Section Structure Positioning and Visualization. Relevant features are accessible via the View menu in
the main menu bar and the tool bar below the main menu bar.

In case you want to save a mesoscale structure as a file to disk, export the structure with File >>

Export to file . The supported file formats are visible in the combo box Files of type: .

It is also possible to save mesoscale structures in structure lists. Saving structures in structure lists is de-
scribed in chapter MedeA HT of the MedeA manual.

To convert a mesoscale structure without periodic boundary conditions to a periodic system invoke Edit >>

Create a periodic copy .
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Hint: MedeA jobs with LAMMPS and GIBBS require structures in simulation cells, i.e. with periodic boundary
conditions.

15.3 Context Menu in the Mesoscale Builder

In general, the context menu of a mesoscale structure window is opened with a right-click somewhere in the
drawing area. However, the displayed menu items depend on whether the pointer is positioned on a bead, a
bond, or the background (anywhere else in the structure window).

Transferring Beads Between Structures

With the following menu items, it is possible to transfer entities (single beads, groups of beads and mesoscale
systems) from one structure into other structures.

• Paste : put previously copied beads into the current structure

• Copy full structure : creates a copy of the entire mesoscale structure, including bond information, bead
type, and other bead properties

• Copy selection : creates a copy of selected beads of a mesoscale structure, including bond informa-
tion, bead type, and other bead properties

Descriptions of all other items of the context menu are as follows:

Modify Internal Coordinates

With the Internal coordinates menu item you can interactively change the internal coordinates of mesoscale
structures such as dihedrals (torsional angles), bond angles, and bond lengths.

Note: This menu item appears if a structure has at least four beads.
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Either use the sliders to decrease or increase the values of particular coordinates one-by-one or enter the
new values in the number fields; the units are Angstroms for distances and degrees for angles. Mesoscale
structures immediately respond to the changes. Add or remove certain internal coordinates with the selectors
+ and - , respectively. Internal coordinates that cannot be modified independently, i.e. without affecting

other internal coordinates due to structural restrictions, are highlighted in red.

To confirm all modifications, close the dialogue with OK . To discard all structural modifications, close the
dialogue with Cancel .

Other features of the Mesoscale Builder used to modify internal coordinates of mesoscale structures require
selected beads.

Note: The following three menu items appear only in the main context menu if a particular number of beads
is selected.

• Distance : Change the distance between two selected and connected (bonded) beads

• Bond Angle : Change the angle between three selected and connected (bonded) beads
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• Dihedral : Change the torsional angle between four selected and connected (bonded) beads

Action Modes

With the Mode menu item changes the action mode.

• Rotate : In this mode, the entire structure can be rotated

• Rotate Selection : In this mode only selected beads of the structure can be rotated

• Translate : In this mode, the entire structure can be translated (moved)

• Translate Selection : In this mode only selected beads of the structure can be translated (moved)

• Zoom : Zoom in/out by moving the pointer or using the arrow keys of the keyboard, zooming is also
possible with the mouse wheel

• Select : Select bead(s) (by clicking on individual beads or dragging the pointer over a relevant region
with beads); selected beads are highlighted in white

• Select Molecules : Select entire molecules and connected atoms, respectively (by clicking on individ-
ual atoms or dragging the pointer over a relevant region with atoms); selected atoms are highlighted in
white

Position all Molecules in the Drawing Area
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With the menu item All collectively move all mesoscale structures, beads, etc. that are present in the
drawing area of the Mesoscale Builder

• Center to origin : Move the common center of mass of all structures to the center of the coordinate
system, i.e. x = y = z = 0.0 (the center of the coordinate system can be visualized with the axes

icon and is at the intersection of the colored cylinders * Center to reference point : Move the

common center of mass of all structures to a reference point that is defined in the References tab of
the Mesoscale Builder.

Selection of Beads

With the menu item Selection either select all beads of a mesoscale structure, clear bead selections, or
modify structures based on the selected beads.

Note: All the following items - except Select all (Crtl-A) require previously selected beads.
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• Select all (Ctrl-A) : Selects all beads; can be also invoked with the keyboard shortcut Ctrl + A

• Clear selection (Esc) : Remove any selection; can be also invoked with the Esc key of the keyboard

• Center to reference point : Move the common center of mass of the selected beads to a reference

point that is defined in the References tab of the Mesoscale Builder

• Delete selected beads (Del) : Erases selected beads and bonds to connected beads; can be invoked

with the Del key of the keyboard

• Delete selected beads only : Erases selected beads but maintains half bonds as stubs (active
bonds)

• Delete overlapping beads : In case a copy of a selection of beads is pasted into an existing structure,
then this option deletes all of pasted beads that are too close to any neighboring beads of the newly
created structure.

• Extend selection by a bond : Expands selection to neighboring beads and beads connected with
bonds

• Extend selection by a region : Expands the selection to atoms around the already selected atoms
independent on whether atoms are connected by bonds
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– Mark the option Define one sphere for entire selection to set the center definition either as

* Geometrical center ,

* Center of mass , or

* Bounding box center (it is the center of an orthorhombic cell that encloses all selected
atoms)

– In case you mark the option Define one sphere per atom of the selection , then no other param-
eters need to be specified except the

• Invert : select all unselected beads and deselect all previously selected beads

• Rotate selection : Rotate selected beads around the Reference vector which is defined in the
References tab of the Mesoscale Builder. The units of rotation angles are degrees.

• Translate selection : Translate selected beads parallel to the Reference vector which is defined in
the References tab of the Mesoscale Builder ; the translation distance is defined by the length of the
Reference vector

• Simple Forcefield Dynamics : Evolves selected beads in 100 molecular dynamics steps, employing a
simple forcefield

• Simple Forcefield Minimization : relaxes selected beads, employing a simple forcefield

Note: The following menu items appear only if a particular number of beads is selected.

• Define repeat unit : If two beads are selected you can set the head and tail of a repeat unit (polymer
‘monomer’) that you can then use in the Polymer Builder to create mesoscale macromolecules

• Reverse repeat unit head and tail : If the head and tail beads of a repeat unit are selected swap the
head and tail of the repeat unit

• Set connecting dihedral angles : Modify all torsional angles between two selected beads. Requires
that the two selected beads are separated by two or more other beads.

Note: This is a very useful feature to set torsional angles in a polymer chain or any other large
mesoscale system.

• Set as reference vector : Define a reference vector with two selected beads; reference vectors are
useful to translate or rotate selected beads along a certain direction or around a particular axis

• Set normal as reference vector : If you have selected three beads, then define a reference vector as
the normal of the surface that is spanned by the three beads; reference vectors are useful to translate
or rotate selected beads along a certain direction or around a particular axis
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Note: All the following items require enabling the mixed visualization mode (click on the icon )

• Display as CPK : visualize selected beads as spheres

• Display as Ball & Sticks : visualize selected beads as balls connected with sticks

• Display as Sticks : visualize selected beads as sticks only

• Display as Lines : visualize selected beads as lines

• Hide : do not show selected beads

Subsets

Within MedeA subsets are sets of beads that belong to particular mesoscale systems, are of the same bead,
have the same forcefield type, are selected at the same time, etc. Subsets are required, for example, to
graphically distinguish groups of beads with different properties using different visualization styles, to analyze
results, or to post-process data from calculations. With the Subset context menu item you can create and
edit subsets.

Note: All the following items - except Create. . . or Create subset from selection. . . require previously
created subsets or previously selected beads, respectively.

• Create. . . : opens the New tab of the Subset Manager to create a new subset based on atomic
properties
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• Create subset from selection. . . : opens the New tab of the Subset Manager to create a new subset
based selected atoms

• Create subset from a connected pattern : opens the New tab of the Subset Manager to create a new
subset based on, e.g. a molecular structure

• Delete atoms in subset : Delete all atoms that form the subset and the subset itself

• Select atoms in subset : Select all atoms that define a subset

• Rename a subset : opens the Operate tab of the Subset Manager to change the name of an existing
subset

• Delete subset : Delete the subset definition but keep the atoms

• Combine subsets : opens the Operate tab of the Subset Manager to create a new subset by com-
bining two or more existing subsets

• Separate subset : opens the Operate tab of the Subset Manager to separate an existing subset

• Randomly filter subset : opens the Operate tab of the Subset Manager to randomly alter the number
of atoms of a particular subset

• Attach Fragments in subset : Connect molecular fragments of atoms to atoms of a subset (more infor-
mation is provided in the Section Attach Fragments)

• Convert subset : Convert a subset with the length 2 in a subset with the length 1. This menu item is
present only if a structure encompasses one or more subsets with a length larger than one.

• Subset summary : opens the Subsets tab of the Subset Manager summarize the properties of exist-
ing subsets

Edit Bead Properties

The Bead context menu item appears upon right-clicking with the pointer over a bead
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• Add Active Bond. . . : Add a half bond (stub) to a bead; the direction of the bond is perpendicular to
the screen

• Center this bead on origin : Move the bead and all connected beads to the center of the coordinate
system, i.e. x = y = z = 0.0 (the center of the coordinate system can be visualized with the axes icon

and is the intersection of the colored cylinders

• Center this bead on reference point : Translate this bead and all connected beads to a reference point

that is defined in the References tab of the Mesoscale Builder

• Change bead type : Replace the bead type of this bead by the bead type selected in the Insertion

tab (this menu item is only active if the Insertion tab is displayed)

• Delete bead only : Delete this bead but maintain the half bonds (stubs) of the connected beads as
active bonds

• Delete bead : Delete this bead and all bonds to connected beads

• Move this bead to reference point : Move only this bead (but not the other beads) to a reference point

that is defined in the References tab of the Mesoscale Builder

Hint: To place the center of mass of a mesoscale system at the center of the simulation box, first,
compute the Center of mass in the Reference tab, multiply it by -1 and then right-click and select
All >> Center to Reference point .

Edit Mesoscale System Properties

The Mesoscale system context menu item appears upon right-clicking with the pointer over a bead
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• Center to reference point : Translate the center of mass of this mesoscale system to a reference point

that is defined in the References tab of the Mesoscale Builder

• Delete : Delete this mesoscale system

• Select mesoscale system : Select this entire mesoscale system

• Unselect mesoscale system : Clear selection of mesoscale system

• Rotate : Rotate this mesoscale system around the Reference vector which is defined in the
References tab of the Mesoscale Builder, the unit of the rotation angle is degrees.

• Translate : Translate this mesoscale system parallel to the Reference vector which is defined in the
References tab of the Mesoscale Builder ; the translation distance is defined by the length of the
Reference vector

Create or Delete Bonds

Note: The following menu item only appears if the structure has bonds and if the right-click is over a bond.

• Delete bond. . . : Deletes the bond underneath the pointer

Note: The following menu item only appears if two beads are selected.

• Create bond : Create a bond between two selected beads.

Check Macromolecules
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• Check for ring catenation : Determine whether bonds/chains of a mesoscale system go through rings
and loops of other mesoscale systems (this is important to avoid ring catenation, in particular in realistic
polymer and polyaromatic models)

Create Periodic Structures

• Create periodic copy : Put all mesoscale systems, beads, etc. in the drawing area in a simulation cell
with periodic boundary conditions, such that the resulting structure can be used in calculations with
LAMMPS and GIBBS; the cell dimensions are defined in the Cell tab of the Mesoscale Builder

Edit bonds

With the menu item Edit bond. . . you can create connections between beads, with the Edit Bonds dialogue.

Tag Beads With Labels

With the menu item Bead labels define in sub-menus which bead properties should be displayed as labels
next to each bead

• Bead : Display the bead type in the structure

• Calculated charge : Display the charge that was calculated

• Name : Display assigned name of the bead

• Number of bonds : Display number of connections to other beads

• Point : Display points of bead

v. 3.9 Copyright © 2024 Materials Design, Inc., All rights reserved.
Materials Design® and MedeA® are registered trademarks of Materials Design, Inc.

12121 Scripps Summit Dr., Ste 160 San Diego, CA 92131

102 of 107



D
O

C
U

M
E

N
TA

TI
O

N
MedeA Documentation

15.4 Insertion Tab

Within the insertion tab, you can select beads to add to mesoscale structures in the drawing area and manage
the families of beads.

In the insertion tab, there are two areas, the list of bead families and beads at the top and the display of
details for the bead selected at the bottom. In the list of bead families, you can expand the table row of each
family to get access to the beads in each family. The list also shows a description of each bead to enable the
picking of the right bead for the construction of a mesoscale system.

When a bead is selected in the list its properties are shown in the lower part of the insertion tab. The following
properties are available:

• Description : The description of the bead is shown and can be changed here

• Mass : The mass of the bead is displayed and can be modified here

• Radius : The radius of the bead is listed and can be adjusted here, the bead radius is only used for
display in the viewer

• Charge : The charge of the bead is provided and can be set here

• Color : Shows the color of the bead to be used in the viewer, use the Select . . . button to bring up a
color selection dialogue to change the color

• Clean : This option relaxes the mesoscale structure in the drawing area with the forcefield selected in
the main menu item Forcefields .

Clicking with the right mouse button in the bead families list shows a context menu for managing the bead
families. It contains the following items:

• New bead : Use this item to create a new bead in the family clicked in

• New bead family : Create a new bead family
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• Delete bead : Delete the bead you have clicked on

• Rename : Rename the bead family or bead you have clicked on

• Save bead family : Save the bead family you have clicked into a file on disk. Store your own bead
families in the folder MedeA/beads in your home directory to make them automatically available in
MedeA on restart.

15.5 References Tab

The References panel lets you define a reference point and a reference vector to perform actions such as
Translate , Rotate , Center single beads, a group of selected beads, individual mesoscale systems, or all

mesoscale systems in the drawing area.

For example, you can define a reference point to be the center of mass of the mesoscale system or a
selection of beads. You can then translate the mesoscale system such that its geometrical center is placed
on the center of mass. Alternatively, you can define a reference point and vector and translate a group of
beads or a mesoscale system around the axis defined by the point and vector.

Reference point

You can type in the values for the x , y , and z coordinates of a point (press the Return key of the keyboard
to confirm) or select special points from the list:

• Geometrical center : geometrical center of all beads in the drawing area

• Center of Mass : center of mass of all beads in the drawing area

– Bounding box center : center of the smallest possible box that encompasses all beads

• Selection geometrical center : geometric center of the selected beads

• Selection center of mass : center of mass of the selected beads

• Selection bounding box center : center of the smallest box that encompasses all selected beads

To set the new reference point click on Compute .

Reference vector

To define a vector, simply input values for the x , y , and z coordinates of the end point of the vector. The
offset or starting point of the vector is defined by the reference point. Alternatively you can select two beads
in the drawing area and invoke right-click >> Selection >> Set as reference vector . The values of the x ,
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y , and z coordinates for the reference point and reference vector are adapted accordingly. Also, you can

scale the vector by setting Multiply by to a value other than 1.0.

Check the box Show References to display the reference point and vector (red bullet and red cylinder in
drawing area).

Hint: Note that beads or bonds may hide the reference point and vector.

15.6 Cell Tab

In the Cell tab defines the dimension of the cell that surrounds the mesoscale systems in the drawing area.
When converted to a periodic structure this cell will be the periodic unit cell and simulation cell in which
structures are located.

When converting a periodic structure into a mesoscale structure the original cell parameters are maintained
and shown by default.

However, you can either explicitly define the cell parameters a , b , c , alpha , beta , and gamma . Alter-

natively, define a void region (a value for the option a cell leaving a gap of ) around the mesoscale system

and leave it to the builder to determine cell dimensions by clicking on Compute .

To show the current cell check the option Show Cell .

If you want to convert a structure to a periodic model click on Create a periodic copy .

16 Mesoscale Converter

The MedeA Mesoscale Converter lets you create mesoscale systems from existing atomistic systems. The
resulting structures are created for use with the MedeA compute engines GIBBS and LAMMPS.
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16.1 Getting Started

You can start the Mesoscale Converter for any active atomistic system via

• invoking Builders >> Map atomistic/mesoscale systems

This opens up a dialogue, where you can select a bead library and define parameters for mapping the
atomistic system to a mesoscale system. The mapping can be applied to both periodic and non-periodic
systems and can also be saved for future use.

16.2 Main Features in Brief

The Mesoscale Converter permits to interactively define a mapping between atoms in an atomistic model
and beads in a mesoscale model. The user can select a bead library, specify substructures in the atomistic
structure and provide bead type, bead mass and bead charge for the beads in the mesoscale model to
create. The Mesoscale Converter will search the atomistic model for the substructures defined and create
an equivalent mesoscale model, where the positions of the beads have been derived by some rules from the
positions of the atoms. The mesoscale system is then displayed in a separate viewer.

16.3 Specifying a Mapping

The user interface for mapping between atomistic and mesoscale systems contains at the top a text field,
where the name of the mesoscale system to be created can be given. By default, this is the name of the
atomistic system prefixed with meso- . Next to it is a combo box, where the bead library for the mesoscale
system can be selected. The library chosen here controls what bead names are available for the mapping.

The mapping between an atomistic and a mesoscale system has to be specified in the central table with the
following parameters

• Conversion mode : Select the mode of conversion, available are

– Atoms to n bead(s) : Create n beads of bead type for the atoms matched

– Ring to n bead(s) : Create n beads of bead type for the ring matched

– n molecule(s) to bead : Create one bead of bead type for the n molecules matched

• Structure : The (sub)structure to be mapped to a bead

• n : Number of beads to generate for (sub)structure

• Bead type : The bead type, which depends on the bead library selected at the top

• Bead mass : The mass of the bead

• Bead charge : The charge of the bead

Next to the fields for the parameters, there are three buttons
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• Set : Use this button to add the selected atoms from the viewer of the atomistic system as
(sub)structure to be matched

• Add : Add another row of parameters

• Delete : Delete this row of parameters

The Structure field is not directly editable. Select the atoms you want to use for the (sub)structure in the
viewer of the atomistic system. Then press the Set button in the row you want to specify the (sub)structure
for. The empirical formula for the (sub)structure appears in Structure field, but in the background a search
pattern taking into account elements and bond orders of the selected (sub)structure is recorded. You can
always display the search pattern by clicking into the Structure field. The search pattern is then shown as
selection in the atomistic viewer (not necessarily with the atoms you have selected for the definition).

At the bottom of the user interface, there is a checkbox labeled Highlight atoms matched by bead definition .
When this checkbox is checked every time a (sub)structure is added or modified in the bead definitions table
all atoms which are matched for this (sub)structure are highlighted in the color of the bead in the atomistic
structure. Please note, that using this option will change the selection in the atomistic structure.

The Load and Save buttons make it possible to load a complete mapping from a file or save it to a file.
These buttons open a standard file selection dialogue to interact with the file system. This way it is possible
to specify a mapping only once and reuse it on other systems.

16.4 Mapping Algorithms

The mapping algorithm is selected with the Conversion mode field. When the Atoms to n bead(s) algo-
rithm is used, the longest possible chain of atoms among the selected atoms is searched first. Along this
chain n beads are created, where each bead will be placed at the geometrical center of the atoms around it,
so that an equal number of atoms contributes to each bead. The Ring to n bead(s) algorithm works almost
the same way, except that instead of the longest possible chain of atoms the ring is used.

The n molecule(s) to bead algorithm first uses a clustering algorithm to identify clusters of n molecules.
Then it assigns one bead for each cluster placing it at the geometrical center of the atoms making up the
cluster.
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